MSA-20 Handwheels User Guide

Document version: MSA20HW-UG-20160421 MSA-21 v6.14
Part number: MRMC-1333-00

© 2016 Mark Roberts Motion Control Ltd. All rights reserved.

No part of this publication may be reproduced, transmitted, or translated by any means — graphical, electronic, or mechanical — including photocopying, recording, taping, or storage in an information retrieval system, without the express written permission of Mark Roberts Motion Control.

Although every care has been taken to ensure that the information in this document is accurate and up to date, Mark Roberts Motion Control continuously strives to improve their products and may make changes to the hardware, firmware, and software described in this document. Mark Roberts Motion Control therefore cannot be held responsible for any error or omission in this document.

All product names mentioned herein are the trademarks or registered trademarks of their respective owners.

<table>
<thead>
<tr>
<th>Contact information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mark Roberts Motion Control Ltd.</strong></td>
</tr>
<tr>
<td>Unit 3, South East Studios</td>
</tr>
<tr>
<td>Blindley Heath</td>
</tr>
<tr>
<td>Surrey</td>
</tr>
<tr>
<td>RH7 6JP</td>
</tr>
<tr>
<td>United Kingdom</td>
</tr>
<tr>
<td>Telephone: +44 (0) 1342 838000</td>
</tr>
<tr>
<td>E-mail: <a href="mailto:info@mrmoco.com">info@mrmoco.com</a> (sales and general enquiries)</td>
</tr>
<tr>
<td><a href="mailto:support@mrmoco.com">support@mrmoco.com</a> (customer support)</td>
</tr>
<tr>
<td>Web: <a href="http://www.mrmoco.com">www.mrmoco.com</a></td>
</tr>
<tr>
<td><a href="http://www.mrmocorentals.com">www.mrmocorentals.com</a></td>
</tr>
</tbody>
</table>
# Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Contents</td>
<td>iii</td>
</tr>
<tr>
<td>Chapter 1</td>
<td>Quick start</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Safety</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Overview</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Mounting and assembling the MSA-20 Handwheels</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Connecting the cables</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Connecting the Handwheels as a stand-alone controller</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Powering up and loading the head</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Turning off the MSA-20 Handwheels and head</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>The MSA-20 Handwheels controls</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Setting the control directions</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Using the control direction switches</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Zeroing the axes</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Zeroing the axes manually</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>Zeroing the axes by homing</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>Setting the soft limits</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Session summary</td>
<td>15</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Using Film mode to record and play back camera movements</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>About Film mode</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Using the Emergency Stop button</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Specifying the camera settings</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Creating a move by defining start and end points</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Creating a move by live recording</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Playing back a move - simple method</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>Playing back a move - advanced method</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>Summary of playback events</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>Using time-lapse playback</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>Modifying a move</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>Deleting a move</td>
<td>33</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Speed controls .............................................................. 34</td>
<td></td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Advanced settings .......................................................... 38</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Setting the axis type .................................................... 39</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Duplicate axis position outputs for stepper motors .......... 39</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Input method .................................................................. 40</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Input dead zone ................................................................ 40</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Back-pan ........................................................................... 41</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Back-pan scale ............................................................. 41</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Serial setup ...................................................................... 42</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Serial B port mode ....................................................... 42</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Serial B port speed ....................................................... 43</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mobo position output ..................................................... 43</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Setting up Preston lens motors ....................................... 44</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Setting up Canon analog lens controls ............................ 45</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Using Canon and Fujinon digital lens controls .................. 47</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Low level settings ......................................................... 49</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Current limits .................................................................. 49</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Temperature limits ......................................................... 49</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PID system motor tunings ............................................... 50</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Motor frequency and polarity .......................................... 50</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Maximum error .................................................................. 51</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Head axes type .............................................................. 51</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Encoder Safety .................................................................. 52</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Axes home type .................................................................. 53</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Head communication statistics ............................................. 54</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wireless communication ...................................................... 54</td>
<td></td>
</tr>
</tbody>
</table>
Appendix 3  Back panel and accessories ........................................ 124
  Panel summary.................................................................124
  Connector pin-out information...............................127
      Camera trigger out ..................................................127
      Auto-focus and bloop trigger out ...................127
      Playback trigger in ...............................................128
      Camera sync in ......................................................128
      GPIO 1 connector .................................................129
      GPIO 2 connector ..................................................130
      Up Link connector ..................................................130
      Down Link connector .............................................131
      Serial A connector ...............................................131
      Serial B connector ...............................................131
      Auxiliary connectors for Focus, and Zoom .........132
      Expansion/Pan Bars connector .........................133
      Power In connector ..............................................134
      Power Out connector ............................................134

Appendix 4  Specifications............................................................. 135
  Index of menu options.............................................136
  Index ........................................................................ 138
Chapter 1  Quick start

Safety

- Do not use around flammable gas. All electrical equipment can generate sparks that can ignite flammable gas.
- Heads have powerful motors that can pinch, so take care not to get your hands trapped in the head or cabling.
- Keep the equipment dry. The system has not been made weatherproof. Do not use with wet hands.
- Keep cables tidy. Use cable ties to keep them out of harm’s way. If you have a head with slip rings then make use of them; avoid running any cables between the base and the rotating head or camera.

Overview

Thank you for using the MSA-20 Handwheels camera head controller from Mark Roberts Motion Control (MRMC). You can use the MSA-20 Handwheels unit as a standalone controller attached to an MRMC camera head or as in integrated addition to a computerised camera installation running Flair Motion Control Software. The MSA-20 Handwheels unit is a robust controller designed for day-in, day-out use in professional studio and Outside Broadcast environments.

The Handwheels give you smooth, precise, real-time control over your choice of three camera axes. The axes can be a combination of head controls (pan, tilt, roll, etc.) and camera controls (typically zoom). You can also plug additional controls into the MSA-20 Handwheels unit such as focus and zoom lens controls, and pan bars.

The controller includes the following features:

- Record and Playback of moves, including camera synchronization - You can create, store, play back, and modify up to 174 axis-minutes of head movements, including lens control movements.
- A-B moves – To define start and end points and automatically create a smooth move between them.
• Time-lapse Playback – to record a move at normal speed and play it back slowly in stop-frame or slow motion mode.
• Back-Pan – You can set up the pan axis to automatically compensate for rotation axis movement to keep the camera on target.
• Soft-limits – to limit the movement ranges of the axes
• Velocity limits – to ensure axes do not trip
• Acceleration limits – to give smooth movement
• Lens axis control – to give absolute position control when required
• Standard axis control – to give relative position control when required
• Control scaling – to allow fine adjustment or a fast response
• Control to motor axis mapping – to switch between controls
• Low level motor control (current limits, motor tunings, etc) – to control a range of small and large motors
• Control of DC servo, Stepper, and serial lens motors (for example Preston) – 6 DC (35V 8A max), 3 Stepper, and 3 serial lens
• Preston controls – Lens movements from a Preston system can be recorded and played back.
• Serial lens control – Both Canon and Fujinon digital lenses can be controlled.
• Wireless Head Communication – MRMC wireless modules can be connected and are automatically detected.
• Flair compatibility - You can connect the MSA-20 Handwheels to a larger system that is using Flair motion control software running on a Windows PC, then use the Handwheels as a slave mimic device to move the rig.
Mounting and assembling the MSA-20 Handwheels

1. Mount the MSA-20 Handwheels main unit onto your choice of support, such as a heavy-duty tripod or metal plate.

2. Mount each handwheel onto an axle, making sure you fit the axle key into the handwheel slot and tighten the thumbscrew securely by hand before moving on to the next handwheel.

Hint

The thumbscrews are captive within the handwheels unless you unscrew them completely. When you remove the handwheels from the unit you only need to unscrew the thumbscrews enough to remove them from the axles. You do not need to unscrew the thumbscrews completely from the handwheels.
Connecting the cables

Connecting the Handwheels as a stand-alone controller

Put the **BOOT MODE** switch to the *Up* position. Attach the power cables last.

24V 5A

The head and controller both use the same type of power supply brick.

See also *Back panel and accessories* on page 124.
Powering up and loading the head

There is no power switch on the MSA-20 Handwheels; the power is on whenever the 24-volt power supply is attached and live. Similarly, there is normally no power switch on MRMC camera heads; the power is on whenever the head has a 24-volt power supply that is live.

1. Attach the power cables to the head and the MSA-20 Handwheels after you have attached all the other cables. Make sure the relevant indicators light up; for example, the power indicator LEDs on all 24Volt power supply bricks ( ), and the power indicator LED on the head ( ).

Hint

It is recommended that you do not use the POWER OUT socket on the MSA-20 Handwheels to power the head if you are using an Ethernet connection to the head. If you do so then powering up the MSA-20 Handwheels will simultaneously power up the head, and in this instance powering up two Ethernet devices at the same time on the same network can cause communication problems between them.

Hint

If you are using an Ethernet connection between the controller and the head it is recommended that you power up the head first and the controller last, as powering up two devices simultaneously on the same network can cause communication problems.

If you are using a Serial connection to the head you must power up the controller first and the head last.

When the MSA-20 Handwheels has power, its screen displays a prompt similar to the following:

(C) MRMC 2016
PRESS SELECT TO
LOAD QUAD ETHER II
The last line of the prompt tells you which operating system will be loaded into the head - in this example **QUAD ETHER II**. Each MSA-20 Handwheels unit is configured at the factory for a specific head, and contains the operating system for that head.

If this prompt does not appear then check that the position of the **BOOT MODE** switch on the MSA-20 Handwheels unit is in the Normal (Up) position for stand-alone operation, then remove and re-attach the power cables.

2. Press the **SELECT** knob to load the operating system into the head. This is called “loading the head”.

If the load is successful, the screen on the MSA-20 Handwheels displays a message similar to the following, and you will be able to move the head with the Handwheels:

```
ETHERNET MODE
CAM FPS: 0.00
```

If you get a message similar to any of the following, see Troubleshooting on page 105:

```
HEAD DID NOT LOAD
HEAD NOT LOADED
LOAD FAIL
FAILED TO LOAD HEAD
```

**Turning off the MSA-20 Handwheels and head**

As there is no power switch on the MSA-20 Handwheels or head, to turn these off you simply remove the power cable. All MRMC controllers and heads have robust electronics that are designed to withstand the rigours of connection and disconnection to live power cables.

You can leave the other cables plugged in if you want.
The MSA-20 Handwheels controls

On the MSA-20 Handwheels, two of the handwheels are typically assigned to the Pan and Tilt head axes, and the third handwheel is typically assigned to Roll or Zoom, although you can change the assignments if you want.

The meanings of the lights on the MSA-20 Handwheels controller are as follows:

- **POWER** - The power is on.
- **RUNNING** - The firmware in the controller is running. This is on even if you have not loaded the head.
- **INHIBIT** - The controller is temporarily in a non-operational state. It does this for example when changing modes.
- **RESET** - This is only on if you have booted up in Flair mode and Flair is resetting the controller.
- **ENABLE 1-5** - Indicates that this numbered axis on the head or camera (for example Pan, Tilt, Roll, Focus, or Zoom) is now...
connected to its corresponding control in the controller (for example \texttt{WHEEL L}, \texttt{WHEEL F}, \texttt{WHEEL R}, \texttt{FOCUS} (auxiliary), or \texttt{ZOOM} (auxiliary)).

Note that the physical effects of most controls are adjustable in the menu, in terms of the \texttt{limit} (range) of motion, \texttt{direction}, \texttt{speed}, \texttt{damping} (smoothing of jerkiness in the controls), \texttt{input exponential} and \texttt{scale} (sensitivity).

\section*{Setting the control directions}

In the MSA-20 Handwheels you need to specify the directions of the wheel controls for your particular head, lens gearing attachments, and preference. To set the control directions you use the procedure below.

1. On the MSA-20 Handwheels, use the \texttt{SELECT} knob (rotate and press) to choose the menu sequence:

   \texttt{GENERAL SETUP > SET DIRECTION}

   or...

   \texttt{GENERAL SETUP > INPUTS SETUP > SET INPUT DIR} (if you are in Engineering mode)

2. Set each sub-option to \texttt{FWD} (forward) or \texttt{REV} (reverse) as you prefer. Test each control after you set it.

\begin{table}[h]
\centering
\begin{tabular}{|l|p{0.7\textwidth}|}
\hline
\textbf{Menu option} & \textbf{Description} \\
\hline
\texttt{WHEEL L} & Handwheels: Left, Front, Right \\
\texttt{WHEEL F} & \\
\texttt{WHEEL R} & \\
\hline
\texttt{FOCUS} & Auxiliary focus control plugged into the MSA-20 Handwheels. \\
\hline
\end{tabular}
\end{table}
Using the control direction switches

The MSA-20 Handwheels unit has three direction control switches across the bottom. Which controls are affected depends on how the switches have been assigned on your particular controller. They are typically assigned to WHEEL L, WHEEL F, and WHEEL R.

The switches perform the same function as the menu option SET DIRECTION mentioned above but are instantly accessible.

The switch settings interact with the SET DIRECTION menu settings as follows:

- **FWD** (Forward) - The control will operate using the direction that you have set in the SET DIRECTION menu option.
- **OFF** - The control will be inactive.
- **REV** (Reverse) - The control will operate in the opposite sense to whatever direction you have set in the SET DIRECTION menu option.
Zeroing the axes

At the beginning of each session, right after loading the head, you need to zero the axes. This defines a base position at which all head positions and lens settings are set to zero (0) in the MSA-20 Handwheels. All limits, lens controls, and moves that are stored in the MSA-20 Handwheels are measured relative to this base position. The zero points themselves are not stored in the head or lens when the power is off, so you need to define them at the start of each session, by zeroing the axes.

You can zero the axes in two ways, depending on how you want to calibrate the head direction:

- **Zero the axes manually** - you use the controls to point the camera in the direction that you want to use as the zero position for the head axes. See Zeroing the axes manually on page 11.

- **Zero the axes by homing** - the MSA-20 Handwheels unit automatically moves the head to its “home” position, and uses that position as the zero position. The “home” position is the head’s centre of motion, as determined by the limit sensors built into the head hardware. You can only use this method if your head has a homing facility and your MSA-20 Handwheels unit is in Film mode. See Zeroing the axes by homing on page 12.

Hint

If you are using a lens with external Lens Control Motors (LCMs), you need to make sure that the MSA-20 Handwheels controls (or any plug-in controls) move the focus, zoom, and iris rings in the correct direction, before you zero the axes. Refer to Zeroing lens axes with external Lens Control Motors on page 117.
Zeroing the axes manually

1. If you have a serial lens with internal motors for the focus, zoom, and iris then you can skip this step.

   If you have a lens with external motors, set the **focus to infinity** (∞), **zoom to wide-angle** (zoomed out all the way), and **iris/aperture to wide open**. Do this either with the MSA-20 Handwheels (if any wheels or plug-ins have been assigned as lens controls) or by moving the gears by hand. Also see *Zeroing lens axes with external Lens Control Motors* on page 117.

2. Use the controls to point the camera head in the direction that you want to use as the zero position for the head axes. (If the head is on rails, also use the controls to move to the zero rail position that you want to use).

   **Hint**
   Some methods for finding a useful zero position are, in order of increasing accuracy and repeatability:
   - Use the controls to point the camera straight ahead.
   - Use the controls to point the camera at a small object in the field of view that is easy to find again in subsequent sessions, such as the corner of a ceiling or desk.
   - Zoom in on the object and centre it in the field of view (but remember to zoom all the way out again after adjusting the direction so that your zoom axis will be correctly zeroed.)
   - If you are in Film mode you can use **DIAGNOSE AXES > LIMIT INPUTS** to display information that tells you when an axis crosses its home position as you move the controls. See page 84.

3. In the MSA-20 Handwheels menu, choose:

   **HOME AXES > DIRECT ZERO ALL.**

   The MSA-20 Handwheels axes settings are now zeroed. Any stored limits and moves are now operational.
Zeroing the axes by homing

Hint

If your head is in an *underslung* configuration (hanging upside-down from its mount) then it is recommended that you use the *manual* method for zeroing the axes (see page 11) instead of the automatic homing method. Depending on the direction settings of the Tilt and Pan axes in the controller, the automatic homing method might pan or tilt the camera into a home orientation that is 180° from your working target orientation, which can be potentially awkward or risky for the attached cables and equipment.

You can only use this method if your head has a homing facility.

1. In the MSA-20 Handwheels menu, choose:
   
   HOME AXES > ALL AXES (if you are in Film mode)

2. The menu panel on the MSA-20 Handwheels prompts you to move the lens controls (focus, zoom, and iris as applicable) to their zero points:
   
   IF USING LCMs FOCUS ON INFINITY, OPEN THE IRIS, ZOOM OUT, AND PRESS SELECT

   You can skip this step if you have a serial lens with internal motors for the focus, zoom, and iris, or if all of your external Lens Control Motors (LCMs) have homing enabled (that is, if the Engineering menu option HOME AXES > SET HOME AXIS TYPE is set to HARD-LIMIT).

   If you have any external Lens Control Motors that have homing disabled (Engineering menu option HOME AXES > SET HOME AXIS TYPE set to DIRECT) then you need to manually set the focus to infinity (∞), zoom to wide-angle (zoomed out all the way), and iris/aperature to wide open, as relevant for that axis. Do this either with the MSA-20 Handwheels (if any wheels or plug-ins have been assigned as lens controls) or by moving the gears by hand. Also see Zeroing lens axes with external Lens Control Motors on page 117.

3. Press **SELECT**.
The head moves its axes to their home positions and all MSA-20 Handwheels axes settings are zeroed. Any stored limits, presets, and moves are now operational.

### Setting the soft limits

In order to prevent damage to cables and other equipment, you can set limits to the range of physical travel of the head movement and lens controls. This is especially important if you have a head without slip rings, where cabling can get wrapped around the head, or if you have a lens with external lens control motors where you need to limit the travel of the lens axes.

Before the limits can be set or applied you need to zero the axes as described in page 10.

**Hint**

The soft limits apply to any live motions that you perform with the MSA-20 Handwheels controls, and to any existing positions and moves that you have recorded previously. If you tighten the limits or zero the axes in a different place, any existing position or move that now extends outside a limit will be restrained; it will only go as far as the limit allows.

If an axis is outside its soft limit then you will only be able to move the axis towards the nearest soft limit.

1. Choose menu option:
   
   **GENERAL SETUP > SET SOFT LIMITS.**

2. The menu shows the current soft limits. For example:

   **PAN SL: ENABLED**
   
   Max: 203923
   Min: -202148

   **TILT SL: ENABLED**
   
   Max: 80365
   Min: -90008

   **ROLL SL: ENABLED**
   
   Max: 153153
   Min: -44461
The numbers in the menu options refer to physical positions of the head or lens axes, relative to the zero point that was set earlier.

3. Set the **MAX** and **MIN** limits that you want. For example to set the pan limits:

3.1 Make sure the **PAN SL** option is set to **ENABLED**.

3.2 Scroll to the **PAN MAX** option and press **SELECT**.

   The **PAN MAX** number in the menu now shows the current pan position of the head (for example 31896), which is updated continuously as you pan the head.

3.3 Use the handwheel to pan the head so that the **PAN MAX** number in the menu goes toward higher numbers (more positive numbers). Stop where you want this end of the physical pan limit of the head to be.

3.4 Press **SELECT**. You have now set the pan maximum limit.

3.5 Scroll to the **PAN MIN** option and press **SELECT**.

3.6 Use the handwheel to pan the head in the other direction, so that the **PAN MIN** number in the menu goes toward lower numbers (or more negative numbers). Stop where you want this end of the physical pan limit of the head to be.

3.7 Press **SELECT**. You have now set the pan minimum limit.

4. Repeat step 3 for the head tilt and position (if on a rail), and for the lens controls (focus, zoom, and iris as applicable).
Hint

You can turn off the limits for one or more axes. For example if you have an Ulti-head or AFC head with slip rings and you want to make use of the 360 degree pan capability, set \texttt{PAN SL} to \texttt{DISABLED}.

For the lens controls you only set the \texttt{MAX} limit, as the \texttt{MIN} limit will have already been set to zero when you zeroed the axes.

For all axes, \texttt{MAX} must be greater (more positive) than \texttt{MIN}. If this is not possible for a particular axis (for example, if focussing closer puts that axis into negative values) then it means that the axis values are increasing in the wrong direction for that axis, on your particular rig. To fix this problem see \textit{Zeroing lens axes with external Lens Control Motors} on page 117.

\section*{Session summary}

After you have initially set up the system for your particular camera lens and preferences, subsequent sessions take less time to set up, especially if you have not disconnected control cables or moved sites. For subsequent sessions at the same site you typically need to do the following at the start of every session.

1. Attach the power cables to the head and MSA-20 Handwheels.
2. Load the head (page 5).
3. Zero the axes (page 10).

If you have moved sites you will need to connect the control cables before the power cables, and then set new soft limits after you have zeroed the axes (page 13).
Chapter 2  Using Film mode to record and play back camera movements

About Film mode

In Film mode you can record the movements of the head and changes to the lens focus and zoom settings (if using the relevant plug-in accessories) as a single “move”, and then play that move again later.

In addition to recording live moves, you can define a move by defining its start and end points (including lens settings and other parameters), and the MSA-20 Handwheels can generate the move by interpolating between the points.

There is no practical limit on the number of moves you can store, although there is a total time limit of 174 axis minutes. For example, if you record the movements of 4 axes simultaneously, the total time storage capacity is about 43 minutes.

The MSA-20 Handwheels unit remembers the stored moves even if you power off, and even if you change modes and then come back to Film mode. To go into Film mode:

♦ In the MSA-20 Handwheels menu choose CHANGE MODE > FILM MODE.

Once in Film mode you record, play, and modify moves by using the menu.
Using the Emergency Stop button

♦ Pressing the **E STOP** button *once* stops all playback immediately, disables all controls on the MSA-20 Handwheels, and makes the head hold its current position.

♦ Pressing the **E STOP** button *again* also cuts power to the head (to stop a runaway head), so will cause the head to droop if it is in a position that is affected by gravity.

The following message is displayed:

**E-STOP DROPPED**

**PRESS BACK AND**
**E-STOP TO RE-ENABLE**

To recover from an Emergency stop:

♦ Press the **E STOP** and **BACK** buttons simultaneously and release, then press the **BACK** button again by itself.

After you recover from a **single-press** E-Stop your axes retain their zero setting so you do **not** need to re-zero them.

After you recover from a **double-press** E-Stop your axes encoders will have lost position so you will need to re-zero them.

**Specifying the camera settings**

Before recording and playing back moves, you need to specify how the MSA-20 Handwheels will trigger the video camera to start and stop recording, along with other camera parameters. To do this:

♦ In Film mode, choose menu option **CAMERA SETUP** and specify the options suitable for your camera.

The following is a summary of the important options:

- **FPS** - Frames Per Second at which the camera is running.
- **LPF** - Lines Per Frame. The number of encoder lines (servo motor) or steps (Stepper motor) that are required when the camera motor rotates in order to expose 1 frame.
The **ENABLE** setting controls how the MSA-20 Handwheels unit triggers the camera when you play back a move. Possible settings are:

- **MOMENTARY** - The camera is not triggered during playback, and you take manual control of the camera trigger instead. The controller generates a continuous high camera trigger signal when you depress and hold the **CAMERA** trigger button, and stops when you release the button, whether or not playback is in progress.

- **TIME-LAPSE** - used only for time-lapse playback. A camera trigger pulse is generated at the start of each frame (see page 29).

- **PULSE** - At the start of playback the controller sends a brief signal to turn on the camera, unless you have already started the camera manually with the **CAMERA** button (panel showing **CAMERA RUNNING**). During playback no further camera trigger signal is sent; the camera keeps running and you cannot turn it off with the **CAMERA** button. At the end of playback the controller sends a brief camera trigger signal to turn off the camera.

- **CONTINUOUS** - At the start of playback the controller starts sending a continuous high signal to turn on the camera. If you have already triggered the camera manually with the **CAMERA** button (panel showing **CAMERA RUNNING**) then the continuous high signal stays on. During playback the controller keeps sending the continuous high signal and the camera keeps running, and you cannot turn it off with the **CAMERA** button. At the end of playback the controller stops the signal, to turn off the camera.
Hint

For **MOMENTARY, PULSE, and CONTINUOUS** settings, if a bloop light is connected to the system (see page 127) the light will flash at the start of move playback, regardless of the **CAMERA RUNNING** status.

For **TIME-LAPSE** mode it is assumed that you won’t have a bloop light, but you might have an auto-focus cable attached to the same output pins (see page 127). An auto-focus signal is generated whenever the camera trigger signal is generated.

- The **CAM SYNC** setting specifies where the controller should look to find the synchronisation (“sync”) signal. This signal is used to control how the movement of the head is synchronised to the camera frames so that repeat passes match, frame for frame. This signal usually comes from the camera, but can also come from a separate “genlock” sync generator, and is used to synchronise the movement of the head with the video frames so that multi-pass shots match, frame-for-frame.
  - **INTERNAL** - (Not operational in this version.)
  - **MSA GPI 1** - the controller expects the sync signal to come in through the **GPI1** pin (pin 10) on the **GPIO 1** connector or the **GPI1** pin (pin 3) on the **GPIO 2** connector.
  - **MSA VIDEO** - (Not operational in this version.)
  - **HEAD** - the controller expects the sync signal to come in via the head, through one of the following connectors:
    - **Trigger In** (pin 3) on the **TRIGGER** connector, on an AFC head that has the optional BCST70 panel or on any head with a Quad-box or Octo-box (SFH-30 head or SFH-50).
    - **GPI1 In** (pin 10, Trigger In 1) on the **CAM ACC** (Camera Accessory) connector on any head with an Ulti-box (SFH-50 head or Ulti-head).
  - **DISABLED** - no synchronisation. Record and playback starts without waiting for a sync pulse from the camera.
If you specify MSA GPI 1 or HEAD, recording or playback of a move will not begin until the controller detects an incoming sync signal through the specified connection. That is, you must start the camera manually to initiate recording or execution of the move, by using the CAMERA button on the controller either before the move starts or while the controller is waiting for the sync signal.

- **SYNC TIMEOUT** - The number of seconds that the controller will wait to receive a sync pulse at the start of the move. If no sync pulse is received in this time then the move will not start and the message **CAM SYNC FAILED** is displayed.

Hint
All synchronization sources are rising-edge triggered. For information on how the sync facility interacts with playback, camera triggering, and bloop light triggering, see *Summary of playback events* on page 28.

Creating a move by defining start and end points

1. In Film mode, choose menu option **REC-PLAY AXES > A->B WAYPOINT MOVE > SET POSITIONS > POS A: STORE CURRENT?**.

2. Move the head to the starting point of the move, and set the lens controls the way you want.

3. Press **SELECT**.

   The starting point is now stored:
   **POS A: STORED**

4. Scroll to **POS B: NOT STORED** and press **SELECT**.

5. Move the head to the end point of the move, and set the lens controls the way you want.

6. Press **SELECT**.

   The end point is now stored:
   **POS B: STORED**
7. Press BACK, then use option **SET MOVE DURATION > MOVE SECONDS**, to set amount of time that you want the move to take, in seconds.

8. Press BACK then use option **SET A->B FAIRINGS > UP FAIRING** to set the acceleration for the start of the move. For example, a value of 25% means that the head will use the first 25% of the movement to accelerate from 0 to the move’s full speed.

9. Use the option **DOWN FAIRING** to set the deceleration for the end of the move. For example, a value of 25% means that the head will use the last 25% of the move to slow from the move’s full speed to 0.

10. Press BACK then use option **GENERATE A->B MOVE** (pressing SELECT again if prompted) to create the move.

    The move is automatically assigned a move number for identification and stored in the MSA-20 Handwheels. For example:

    A->B MOVE GENERATED
    PROGRESS: 100%
    MOVE #8

11. Press BACK then test the move by using the following sequence:

    11.1 **RUN GENERATED MOVE > PLAYBACK SAME SPEED.**

    11.2 When the panel displays **READY TO GOTO**, press SELECT to go to the start position of the move. (When moving to the start position, the panel displays **PERFORMING GOTO**.)

    11.3 When the panel displays **READY TO SHOOT**, press SELECT to begin playing the move. (When playing a move, the panel displays **SHOOTING**.)
Creating a move by live recording

1. In Film mode, choose menu option REC-PLAY AXES > RECORD.

2. Use SELECT REC AXES to select which axes you want to include in the recording. Each axis can have one of the following values:
   - LEARN - (not operational in the MSA-20 Handwheels.)
   - LIVE - This axis will not be recorded, although you can still move it with the controls during both recording and playback.
   - RECORD - This axis will be recorded. (The default setting)
   - IGNORE - This axis will not be recorded. During playback this axis will hold its position and you will not be able to move it with the controls.

   If an axis is UNASSIGNED then there is no control mapped to it; it will not be recorded as you will not be able to move it with the controls.

3. Press BACK, then choose menu option RECORD.

   The panel shows NOT RECORDING, along with the ID number of the move about to be recorded, and the recording time left. For example:
4. Move the head and lens controls to the start positions of the move.

5. Press **SELECT** to start the recording.

6. Move the controls to make the motion that you want to record.  
   The **TIME LEFT** amount decreases as you record.

7. When you have finished the move, press **SELECT** which stops recording and saves the move.
   The panel shows **NOT RECORDING**, along with the ID number of the next move to be recorded, if you choose to do so.

8. If you want to record another move, repeat steps 4 to 7. Otherwise press **BACK** twice then **PLAYBACK > PLAYBACK SAME SPEED** to play the move.

   If you press the **BACK** button while recording a move, the recording is aborted. You are returned to the **REC-PLAY AXES** menu and the move is not stored.

**Hint**

If the MSA-20 Handwheels unit is set to wait for a sync signal (**CAMERA SETUP > CAM SYNC**, see page 19) then the controller displays the message **AWAITING CAM SYNC** and recording will not start until a sync pulse is received from the specified sync source. If you are using a sync source from the camera you must start the camera to start recording, for example by pressing the **CAMERA** button.

The message **CAM SYNC FAILED** appears if no sync signal is received within the time that you specified in **CAMERA SETUP > SYNC TIMEOUT**.
Playing back a move - simple method

Hint

In the context of the MSA-20 Handwheels and this manual, the term “Playback” refers only to the move that is being played by the MSA-20 Handwheels. The camera itself is either broadcasting or recording pictures or video, while the MSA-20 Handwheels unit is “playing back” its move.

1. In Film mode, choose menu option REC-PLAY AXES > PLAYBACK > SELECT PLAY MOVE.

2. Use the SELECT knob to choose which move you want to play. For example, move #7:

```
MOVE 5  00:00:10
MOVE 6  00:00:10
MOVE 7  00:00:10<
MOVE 8  00:00:10
```

3. Press BACK then PLAYBACK SAME SPEED.

4. When the panel displays READY TO GOTO, press SELECT to go to the start position of the move. (When moving to the start position, the panel displays PERFORMING GOTO.)
5. When the panel displays **READY TO SHOOT**, press **SELECT** to begin playing the move. (When playing a move, the panel displays **SHOOTING**.)

**Hint**

If the MSA-20 Handwheels unit is set to wait for a sync signal (**CAMERA SETUP > CAM SYNC**, see page 19) then the controller displays the message **AWAITING CAM SYNC** and playback of the move will not start until a sync pulse is received from the specified sync source. If you are using a sync source from the camera you must start the camera to start playback, for example by pressing the **CAMERA** button.

The message **CAM SYNC FAILED** appears if no sync signal is received within the time that you specified in **CAMERA SETUP > SYNC TIMEOUT**.

If necessary, you can stop a move at any time by using the **BACK** button.
Playing back a move - advanced method

1. In Film mode, choose menu option **REC-PLAY AXES > PLAYBACK > SELECT PLAY MOVE**.

2. Use the **SELECT** knob to choose which move you want to play. For example, move #7:

   MOVE 5  00:00:10
   MOVE 6  00:00:10
   MOVE 7  00:00:10<
   MOVE 8  00:00:10

3. Press **BACK** then **PLAY OPTIONS** to specify the options you want:

   - **REPEATS**: the number of times you want the move to be played back. A setting of **INFINITE** will replay the move continuously until you press **BACK** to stop it.

   - **REC. SPEED**: the speed of the camera (frames per second) used when the move was recorded. This number affects the playback speed, which is also related to the number of frames per second that is specified in the menu option **CAMERA SETUP >FPS**. For example, for a move originally defined as a 10-second move:

<table>
<thead>
<tr>
<th>REC-PLAY AXES &gt; PLAYBACK &gt; PLAY OPTIONS &gt; REC. SPEED</th>
<th>CAMERA SETUP &gt; FPS</th>
<th>Actual playback time (seconds)</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>25</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>25</td>
<td>4</td>
</tr>
<tr>
<td>25</td>
<td>10</td>
<td>25</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>10</td>
<td>5</td>
<td>20</td>
</tr>
</tbody>
</table>
4. Press **BACK** then **PLAYBACK ANY SPEED**.

5. When the panel displays **READY TO GOTO**, press **SELECT** to go to the start position of the move. (When moving to the start, the panel displays **PERFORMING GOTO**.)

6. When the panel displays **READY TO SHOOT**, press **SELECT** to begin playing the move. (When playing a move, the panel displays **SHOOTING**.)

**Hint**

You can think of the **REC. SPEED** (first column) as the original number of frames per second that the move was designed for when recording the move, and the **FPS** (second column) as the number of frames per second that the camera is actually using when the move is played back. If these are different, the MSA-20 Handwheels will automatically adjust the speed of the playback a proportionate amount so that the overall move still contains the same number of frames, taken at exactly the same head positions and lens settings.

If necessary, you can stop a move at any time by using the **BACK** button.

**Hint**

If the MSA-20 Handwheels unit is set to wait for a sync signal (**CAMERA SETUP > CAM SYNC**, see page 19) then the controller displays the message **AWAITING CAM SYNC** and playback of the move will not start until a sync pulse is received from the specified sync source. If you are using a sync source from the camera you must start the camera to start playback, for example by pressing the **CAMERA** button.

The message **CAM SYNC FAILED** appears if no sync signal is received within the time that you specified in **CAMERA SETUP > SYNC TIMEOUT**.
Summary of playback events

If camera sync is disabled (page 19), the sequence of events when you try to play a move is as follows:

1. **READY TO GOTO**
2. **SELECT**
3. **PERFORMING GOTO**
4. **READY TO SHOOT**
5. **SELECT**
6. **SHOOTING** (Controller simultaneously starts the move, sends a camera trigger signal, and sends a bloop trigger signal.)

If camera sync is enabled (page 19), the sequence of events when you try to play a move is as follows:

1. **READY TO GOTO**
2. **SELECT**
3. **PERFORMING GOTO**
4. **READY TO SHOOT**
5. **SELECT**
6. **AWAITING CAM SYNC**
7. Controller automatically sends a camera trigger signal
8. Camera starts
9. Controller receives sync signal from the camera or other sync generator
10. **SHOOTING** (Controller simultaneously starts the move and sends a bloop trigger signal.)
Using time-lapse playback

When you play back a move on the MSA-20 Handwheels using the time-lapse facility, the head and lens perform the same motions as during normal playback, but the MSA-20 Handwheels unit sends a camera trigger pulse to take a frame (single exposure) at regular time intervals along the way. The resulting camera exposures can then be played back later as a video which gives the illusion of compressed time, where slow events occur quickly on the screen.

The controller also sends an auto-focus trigger pulse when it sends a camera trigger pulse. For technical details, see Camera trigger out on page 127 and Auto-focus and bloop trigger out on page 127.

1. In Film mode, choose menu option CAMERA SETUP.
2. Change the ENABLE option to TIME-LAPSE. This sends a trigger to the camera at the start of each frame during time-lapse playback.
3. Press BACK then REC-PLAY AXES > TIME LAPSE > SELECT TL PLAY MOVE.
4. Use the SELECT knob to choose which move you want to play. For example, move #7:

   MOVE 5  00:00:10
   MOVE 6  00:00:10
   MOVE 7  00:00:10<
   MOVE 8  00:00:10

   Selection indicator

5. Press BACK then TL OPTIONS to specify the options you want:
   - **FRAMES**: the total number of exposures you want the camera to take during the move.
   - **FRAME TIME**: the number of seconds between exposures. 
     
     \[(\text{FRAMES} \times \text{FRAME TIME}) = \text{total time to execute the move.}\]
The following example uses **FRAMES: 4, FRAME TIME: 10**, giving a total playback time of 40 seconds.

Note that because the controller takes frames at both the start and end of the move, it actually takes a total of **FRAMES +1** frames, so 5 total frames in the above **FRAMES: 4** example. This makes it easy to calculate the total time as **FRAMES \times FRAME TIME**.

- **TYPE**: One of:
  - **SLOW-MOTION** - the head and lens settings don’t stop during the exposures. The move is played as one continuous motion, and the camera is triggered at the correct points along the way.
  - **STOP-FRAME** - the head and lens axes stop just before triggering each exposure. The head and lens axes essentially perform a go-to at each frame, then stop and hold position while the frame is exposed. If you choose this option, the MSA-20 Handwheels unit also calculates and displays a **MIN FRAME** value. The **FRAME TIME** that you specify above must be larger than this value so that the axes have enough time to accelerate, move, decelerate, and stop between exposures.

In the above example, the slow motion and stop-frame playback would each take 40 seconds of total running time. The stop-frame would execute the move in four distinct motions, each of which would come to a stop just as the trigger point is reached.

6. Press **BACK** then **TL PLAYBACK**.
7. When the panel displays **READY TO GOTO**, press **SELECT** to go to the start position of the move. (When moving to the start, the panel displays **PERFORMING GOTO**.)

8. When the panel displays **READY TO SHOOT**, press **SELECT** to begin playing the move. (When playing a move, the panel displays **SHOOTING**.)

If necessary, you can stop a move at any time by using the **BACK** button.

**Modifying a move**

To modify a move you play it back in a special way, replacing one or more of the axes with live controls. The original move remains unchanged in the MSA-20 Handwheels and the modified move is stored as a complete new move. You typically use this facility to manually correct a lens setting, such as focus.

1. In Film mode, choose menu option **REC-PLAY AXES > MODIFY > SELECT PLAY MOVE**.

2. Use the **SELECT** knob to choose which move you want to modify. For example, move #7:

   - MOVE 5: 00:00:10
   - MOVE 6: 00:00:10
   - MOVE 7: 00:00:10
   - MOVE 8: 00:00:10

3. Press **BACK** then **SELECT MOD AXES**.

4. Choose which axis you want to modify by changing its setting to **MODIFY**. For example:

   - **FOCUS**: **MODIFY**

   Make sure that any recorded axis motions that you want to keep are set to **PLAY**.

   If any axes are using **LIVE** or **IGNORE** status in the move then you can keep the original status or change it to **MODIFY** to include it in the new recording. Once an axis is included in the recording you cannot modify its status back to **LIVE** or **IGNORE**.

5. Press **BACK** then **RECORD MOD**.
6. When the panel displays **READY TO GOTO**, press **SELECT** to go to the start position of the move. (When moving to the start, the panel displays **PERFORMING GOTO**.)

The panel also displays the ID number of the move that you are modifying, the ID number of the modified move that will be created, and the total time of the move. For example:

```
PLAY #7, REC #9
TIME LEFT: 00:00:06
```

7. When the panel displays **READY TO SHOOT**, press **SELECT** to begin playing the move. (When playing a move, the panel displays **SHOOTING**.)

```
PLAY #9, MOD #10
TIME LEFT: 00:00:06
```

---

**Hint**

If the MSA-20 Handwheels unit is set to wait for a sync signal (**CAMERA SETUP > CAM SYNC**, see page 19) then the controller displays the message **AWAITING CAM SYNC** and playback of the move will not start until a sync pulse is received from the specified sync source. If you are using a sync source from the camera you must start the camera to start playback, for example by pressing the **CAMERA** button.

The message **CAM SYNC FAILED** appears if no sync signal is received within the time that you specified in **CAMERA SETUP > SYNC TIMEOUT**.

---

8. As the move plays, use the live controls to move the selected axis the way you want. Concentrate only on that axis; the others will be insensitive to the controls.

When the move finishes it is automatically stored with your modification and you can immediately create another modified move, in case your previous modification wasn't quite perfect.

```
READY TO GOTO
PLAY #9, MOD #10
TIME LEFT: 00:00:06
```

9. If you want to do another take, press **SELECT** and repeat steps 7 to 8. Otherwise press **BACK** twice then **PLAYBACK > PLAYBACK SAME SPEED** to check the final modified move.
Deleting a move

1. In Film mode, choose menu option **REC-PLAY AXES > DELETE > DELETE MOVES**.

2. In the panel, select all the moves that you want to delete:

   
   MOVE 5  00:00:10
   MOVE 6  00:00:10<
   MOVE 7  00:00:10<
   MOVE 8  00:00:10

3. Scroll to the **HOLD SEL HERE 2 DEL** option at the top of the list and press **SELECT**.

   The moves are deleted, and system memory is rearranged to provide the maximum amount of free space for recording more moves. If a large amount of memory has been used up then the delete process may take some time to complete (worst case is 1 minute 22 seconds).
Chapter 3 Speed controls

The following is a summary of the controls that have an effect on the speed of the rig.

- **SCALE** knobs and switches on the MSA-20 Handwheels. These control the general speed of the head movement when using manual controls. It has no effect on playback speed, and no effect on the lens controls (focus, zoom, or iris).

- **Maximum speed**
  
  GENERAL SETUP > AXES SETUP > SET MAX SPEED in Engineering mode.
  
  The maximum allowed axis speed.

- **Scaling of controls**
  
  GENERAL SETUP > SET INPUT SCALE % in Film mode or...
  
  GENERAL SETUP > INPUTS SETUP > SET INPUT SCALE % in Engineering mode.
  
  The amount of scaling to be applied to each control, entered as a percentage of the maximum that the control is capable of.

- **Scaling of axes**
  
  GENERAL SETUP > SET SCALES in Film mode or...
  
  GENERAL SETUP > AXES SETUP > SET SCALES in Engineering mode.
  
  The amount of scaling to be applied to the axes. The number is the ratio of movement between the head axis and the handwheel to which it is mapped. For example a value of 2.5 gives an axis:handwheel movement ratio of 2.5:1. To automatically calculate the scale so the axis range matches the range of a FIZ pot controller, see page 121.

- **Damping** - maximum allowed
  
  GENERAL SETUP > SET DAMPING % in Film mode, or
  
  GENERAL SETUP > INPUTS SETUP > SET DAMPING % in Engineering mode.
  
  The amount of smoothing to be applied to the controls, in order to filter out sudden movements and twitches.

- **Damping** - maximum possible
  
  GENERAL SETUP > INPUTS SETUP > SET DAMPING in Engineering mode.
  
  The amount of smoothing to be applied to the controls. The
number that you specify here is the maximum amount of position change that is allowed within a specific time frame. Movements faster than this are clipped and averaged to stay within this limit as the movement is constantly integrated over time. Higher numbers allow greater acceleration (and deceleration). Lower values limit the allowed acceleration, giving a smoother response. Values in the range 10 to 200 are usually suitable. The SET DAMPING % option (see above) is a percentage of this number, inverted so that 0% = no damping (very responsive system) and 100% = maximum damping (smoother system).

- **Maximum acceleration** - maximum allowed
  
  **GENERAL SETUP > SET MAX ACCEL %** in Film mode or
  **GENERAL SETUP > AXES SETUP > SET MAX ACCEL %** in Engineering mode.
  
The maximum allowed acceleration of the axes, as a percentage of the maximum possible acceleration.

- **Maximum acceleration** - maximum possible
  
  **GENERAL SETUP > AXES SETUP > SET MAX ACCEL** in Engineering mode.
  
The maximum possible axis acceleration.

- **Input exponential**
  
  **GENERAL SETUP > SET INPUT EXP** in Film mode or
  **GENERAL SETUP > INPUTS SETUP > SET INPUT EXP**.
  
The sensitivity gradient of the controls; that is, the relationship between the amount that you move the control (such as a handwheel) and the resulting speed of the motion:
• **Zoom Related Speed**

  **GENERAL SETUP > SET ZRS > ZRS SCALE** in Film mode.
  When you are zoomed in, the head automatically slows down by an amount proportional to the zoom setting. You can adjust this by using the menu option. The higher the number, the greater the slowing effect. You can also specify:
  
  – **SET ZRS > ZRS MASTER** - Choose which axis to use as the reference axis. You usually choose ZOOM.
  
  – **SET ZRS > (Controls)** - Choose which controls you want to slow down, by changing **OFF** to **ON**. You usually choose whichever controls have been assigned to Pan and Tilt, such as WHEEL L and WHEEL F.

• **Feathering**

  **GENERAL SETUP > SET FEATHERING** in Film mode.
  The maximum deceleration an axis is allowed to have as it approaches a soft limit. The lower the feathering value, the sooner the axis starts to slow down as it approaches its soft limit. The higher the value, the closer the axis gets to the soft limit before it starts slowing down to come to a stop.
• **Goto speed**

  General Setup > Set Goto Speed % in Film mode.

  The speed of the head when going to the start of a move (in Film mode). You set this as a percentage of the maximum axis speed.
Chapter 4  Advanced settings

Caution

Many of the features in this chapter are only accessible in the Engineering menu (CHANGE MODE > ENGINEERING MODE). Engineering mode is only for advanced users, as applying the wrong settings here can stop the system from working. When you go into Engineering mode you are prompted for a four-digit PIN, which is 4217. Apply the settings in Engineering mode carefully, and make a note of the changes so you can revert to the previous settings if the system stops working.

For a comprehensive listing of the menu-based features in the MSA-20 Handwheels, refer to Appendix 1 Menu reference. This chapter describes some of the advanced features for which you might need more information than that provided in the menu listing.

This chapter covers the following topics:

- Setting the axis type on page 39
- Duplicate axis position outputs for stepper motors on page 39
- Input method on page 40
- Input dead zone on page 40
- Back-pan on page 41
- Serial setup on page 42
- Setting up Preston lens motors on page 44
- Setting up Canon analog lens controls on page 45
- Using Canon and Fujinon digital lens controls on page 47
- Low level settings on page 49
- Axes home type on page 53
- Head communication statistics on page 54
- Wireless communication on page 54
Setting the axis type

Engineering mode:

GENERAL SETUP > AXES SETUP > SET AXIS TYPE

This is a legacy option that is no longer used. The axis type for all axes on the system must be set to MSA STND (MSA Standard). The parameters for the other axis types are now set elsewhere in the menus and ignored here.

Duplicate axis position outputs for stepper motors

Engineering mode:

GENERAL SETUP > AXES SETUP > SET INTERNAL AXES

When you move the controls or play back a move on the MSA-20 Handwheels, the unit internally generates target positions for the axes which the PID system in the unit tries to closely follow, using feedback from the encoders in the head. You can output these internally generated target positions to one or two external devices that use stepper motors, even if you don’t actually have a head attached to the MSA-20 Handwheels.

The output goes through the General Purpose Output (GPO) pins on the EXPANSION connector (25-way D-Type):

- Output Axis 1:
  - pin 9 (GPO6, Step 1)
  - pin 10 (GPO7, Direction 1)

- Output Axis 2:
  - pin 11 (GPO8, Step 2)
  - pin 12 (GPO9, Direction 2)

You specify which axes to output by using GENERAL SETUP > AXES SETUP > SET INTERNAL AXES. For example:

AXIS1: MTR: PAN
AXIS2: MTR: TILT

If a slave stepper axis is not assigned to a master axis then the corresponding GPO output pins behave as LED enable outputs which activate, for example, the ENABLE LEDs on any mimic-only Handwheels that you have attached to the MSA-20 Handwheels via the EXPANSION connector.
**Input method**

Engineering mode:

`GENERAL SETUP > INPUTS SETUP > SET INPUT METHOD`

The input method for each control can be set to Normal or Speedboat:

- **Normal** – Control input position affects motor position. The axis only moves when the control is moving.
- **Speedboat** – Control input position affects motor speed. This requires a speedboat style controller such as a joystick. The greater the distance from centre in the control, the greater the speed of the axis.

**Input dead zone**

Engineering mode:

`GENERAL SETUP > INPUTS SETUP > SET INPUT DEADZONE`

The dead zone is the amount of control movement (away from some centre or zero position) that is required to make the head start to respond. This intentional “slack” is designed to keep the extremely sensitive controls from constantly moving the head due to tiny fluctuations from, for example, vibration, looseness or wear in the controller mechanics, voltage fluctuations, or an operator’s hand resting on the controls.

You set the dead zone independently for each control, and it only affects inputs that use the Speedboat input method (see above).

If you find that an axis is spontaneously creeping off position (especially in a high-noise environment) increase the dead zone for the control for that axis.

If you have to move a control an excessive amount before its corresponding axis starts to move, decrease the dead zone.

You can fine-tune the dead zone value for some controls, such as those controlling Pan and Tilt axes, by listening to the head motors in a quiet environment. Decrease the dead zone value to find the point where you can hear the motor just barely start to spontaneously whine, then set the value 5 or 10 above that point to give the system some slack. The motors should be completely still (and silent) when you are not touching the controls.
Back-pan

Film mode:
GENERAL SETUP > SET BACK-PAN

Engineering mode
GENERAL SETUP > BACK-PAN SETUP

The back-pan facility is a simple form of target tracking that allows you to link two axes so that when one rotates, the other compensates to keep the camera on target or pointed in the same direction. The menu sub-options are as follows:

- **BP** - toggles the back-pan facility on and off: **ENABLED** or **DISABLED**.
- **PAN AXIS** - the slave axis to which compensation is applied - usually **PAN**.
- **BP AXIS** - the master axis, whose movement triggers compensatory movement of the slave axis - usually a rotate axis on another part of the rig.
- **BP SCALE** - The amount of compensation to be applied to the slave axis. This is calculated by the controller (see below).

For example with a head mounted on a crane, assign the crane's **ROTATE** axis to the **BP AXIS**, and the head's **PAN** axis to the **PAN AXIS**. Rotating the crane would automatically pan the head to keep the camera on target. The link is one-way; that is, you can still move the Pan axis with the controls but this has no effect on the Rotate axis.

Similarly, you could apply back-pan to Tilt and Lift axes, so that lifting the head higher with a crane tilts the camera down to stay on target.

**Back-pan scale**

To set the amount of compensation to be applied to the slave axis you use the **BP SCALE** option (see above) in combination with head axis positions, and the controller automatically calculates the scaling factor that is required to stay on target:

1. Select the **BP SCALE** menu option.

   You are prompted to move the slave axis into position. For example:
2. Move both the master axis (BP-AXIS) and slave axis (PAN AXIS) to some base position.

3. Press SELECT.

You are prompted to move the master and slave axes into their new positions. For example:

MOVE ROTATE
RE-ALIGN PAN
AND PRESS SELECT

4. Move both the master axis (BP-AXIS) and slave axis (PAN AXIS) to their new positions. The further apart the new and old positions are, the more accurate the scaling calculation will be.

5. Press SELECT.

The controller calculates the scale.

6. Press SELECT again to finish.

Serial setup

The options in the GENERAL SETUP > SERIAL SETUP menu only apply to the SERIAL B port, which you can use to archive moves, connect to Preston lens motors, and output live control positions to a computer.

Serial B port mode

Engineering mode:
GENERAL SETUP > SERIAL SETUP > MODE

The serial setup options control the behaviour of the SERIAL B connector on the controller.

Possible values for MODE are:

- **ARCHIVER** - to use the SERIAL B port to connect to a PC, in order to use the legacy MSA Move Archiver and Re-Flash Utility on a PC to backup or restore moves and settings on the controller. This practice has largely been replaced by the MSA Ethernet Archiver described in Chapter 5.
• **MOBO** - “Motion Box” - to use the **SERIAL B** port to output the live control positions to a PC, to use the controller as a mimic input device for CGI programs. See *Mobo position output* on page 43.

### Serial B port speed

**Engineering mode:**

**GENERAL SETUP > SERIAL SETUP > SPEED**

Possible values are:

- **DEFAULT** = 115200 bps for Archiver mode or 38400 bps for Mobo mode. Use this setting if you are using the *ARCHIVER* or *MOBO* serial mode (see above).
- One of: 288000, 192000, 115200, 76800, 57600, 38400, or 19200 bps (bits per second)

### Mobo position output

When you set the **GENERAL SETUP > SERIAL SETUP > MODE** menu option to **MOBO** (Motion Box), the controller outputs 3 floating point positions through the **SERIAL B** port, which represent the positions of the first three control inputs. The rate at which they are output is dependent on the following factors:

1. If the controller is communicating with the head then the output rate is 50Hz
2. If the controller is not communicating with the head and there is no video sync then the output rate is 50Hz
3. If the controller is not communicating with the head and there is a video sync source then the output rate is double the video sync source. That is, with a video sync source of 30fps the output rate is 60Hz.

The data is in ASCII text format and can be viewed on a connected PC using a simple terminal application such as PuTTY. The data format is as follows:

“R:ff, aaa.aaaa bbb.bbbb ccc.ccc”

Where

ff = frame, for example 34
aaa.aaaa = floating point position 1, range -999.9999 to 999.9999
bbb.bbbb = floating point position 2, range -999.9999 to 999.9999
ccc.cccc = floating point position 3, range -999.9999 to 999.9999
The data is terminated with a carriage return.
The Default speed for Mobo output is 38400 bps.
For Mobo position data output set the mode (GENERAL SETUP > SERIAL SETUP > MODE) to MOBO and the speed (GENERAL SETUP > SERIAL SETUP > SPEED) to DEFAULT.

Setting up Preston lens motors

Preston Lens motors can be used with the MSA-20 Handwheels in record and playback. Although Preston Lens motors have their own separate Preston Hand Unit controller, the MSA-20 Handwheels can still read the Preston encoders, via the head, and record their positions when you record a move. When you play back the move, the MSA-20 Handwheels unit takes control of the Preston Lens motors and repeats the move with all recorded axes including the Preston Lens motor moves recorded from the Preston Hand Unit. When you exit playback, control of the Preston motors returns to the Preston Hand Unit, and the motors automatically move back to the current Hand Unit position.

1. Set up the Preston controls as normal with the Preston Hand Unit controlling the Preston MDR2 Lens Control Motor, either wireless or wired.
2. Connect the Preston MDR2 Lens Control Motor to the Head via the Serial connector on the MDR2 (3-pin Lemo) using an MRMC cable.
3. Load the Head as normal.
4. In the Engineering menu choose GENERAL SETUP > AXES SETUP > SET AXIS NAME and change the name of the axis that you want to use for the Preston axis to one of: PN ZOOM, PN FOCUS, or PN IRIS. For example:
   AXIS10: PN ZOOM
   We recommend using axes 10, 11, and 12 for the Preston lens controls.
5. Choose menu option **GENERAL SETUP > LOW LEVEL SETUP > SET HEAD AXES TYPE** and for the Preston axes set the type to **LENS ZOOM**, **LENS FOCUS**, or **LENS IRIS** as appropriate.

6. If you intend to include Preston moves when recording a move, in the menu choose **REC-PLAY AXES > RECORD > SELECT REC AXES**, scroll down to any Preston (PN) axes that appear at the bottom of the list, for example **PN ZOOM**, and make sure the Preston axes are set to **RECORD**.

To record a move with the Preston controls you do so as normal, using the MSA-20 Handwheels to control the standard axes such as Pan and Tilt, and the Preston Hand Unit to control the Preston motors.

To play back a move that includes Preston moves you play the move as normal on the MSA-20 Handwheels. The MSA-20 Handwheels takes control of the Preston motors and uses the recorded data to position the Preston motors. The Preston Hand Unit will have no control during playback. When exiting playback the Preston Hand Unit regains control of the Preston motors, which do a small go-to to match the current Hand Unit positions.

**Setting up Canon analog lens controls**

To use a Canon analog lens you can use the MSA-20 Handwheels in combination with an AFC head that is fitted with a BCST 070 panel. This panel has an **ANALOG LENS** connector suitable for a Canon analog lens, for example the KJ20X8.5B KTSM.

To set up the lens for use with the MSA-20 Handwheels follow these steps:

1. Set up the Canon lens controller as normal with the lens controller being powered from the camera.

2. Connect the lens controller to the AFC head via the 12-pin **ANALOG LENS** connector.

3. Load the AFC head as normal.
4. Use Engineering menu option `GENERAL SETUP > AXES SETUP > SET AXIS NAME` to assign suitable names to the lens axes, such as `FOCUS` and `ZOOM`.
   For example:
   
   **AXIS6: ZOOM**
   
   We recommend using axes 5 to 8 for the Canon analog lens controls.

5. Assign a control inputs to the Canon lens axes, using `GENERAL SETUP > INPUTS SETUP > SET CONTROLLER`.

6. Choose Engineering menu option `GENERAL SETUP > LOW LEVEL SETUP > SET HEAD AXES TYPE` and for the Canon analog lens axes set the type `D TO A`.

7. If a control is controlling the lens position (normal input, as opposed to speedboat input) the lens velocity in the case of speedboat inputs) then you need to set the scaling give control of the full range of movement, using `GENERAL SETUP > AXES SETUP > SET SCALE POTS` and `GENERAL SETUP > AXES SETUP > SET POT RANGE`. If the controller for an axis is changed then you must repeat this step to give the correct scaling.

8. If a control is controlling the lens velocity (speedboat input, as opposed to normal input) then you can set the scaling manually to adjust the affect of the speedboat input on the lens velocity, using `GENERAL SETUP > AXES SETUP > SET SCALES`.

9. The Canon lens position is directly proportional to the Voltage applied to it. Since this is automatically limited it is not necessary to use Soft Limits. To disable the soft limits use `GENERAL SETUP > AXES SETUP > SET SOFT LIMITS`.

10. For the full range of travel of the lens to be achieved you must calibrate the lens. To do this move each control to its maximum travel in both directions.

11. If the lens is moving in the wrong direction for the control then change the axis direction using `GENERAL SETUP > AXES SETUP > SET DIRECTION`. 
Using Canon and Fujinon digital lens controls

Heads that have a lens serial port can control Canon and Fujinon digital lenses. Any lens axis (focus/zoom/iris) that is motorized can be controlled through the MSA-20 Handwheels. The following steps will allow you to control a digital lens.

1. Connect your serial lens cable to the lens serial port on the head, such as:
   - The CAM ACC connector on the Ulti-box (on an Ulti-head or SFH-50 head) or...
   - The Lens connector on an AFC head.

2. Connect the other end of the cable to the lens. Note that some lenses have more than one serial port and you must use the correct one in order to have control of the lens.

3. Power the lens and the controller system and load the head as normal.

4. In the Engineering menu select **GENERAL SETUP > LOW LEVEL SETUP > SET HEAD AXES TYPE** and specify the axis settings according to the head type. For example:

<table>
<thead>
<tr>
<th>Axis</th>
<th>Ulti-box (Ulti-head or SFH-50)</th>
<th>AFC 100</th>
<th>AFC 180</th>
<th>AFCH 100</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Servo</td>
<td>Stepper</td>
<td>CAN</td>
<td>Lens Focus</td>
</tr>
<tr>
<td>2</td>
<td>Servo</td>
<td>Stepper</td>
<td>CAN</td>
<td>Lens Zoom</td>
</tr>
<tr>
<td>3</td>
<td>Servo</td>
<td>Lens Focus</td>
<td>Lens Focus</td>
<td>Lens Iris</td>
</tr>
<tr>
<td>4</td>
<td>Servo</td>
<td>Lens Zoom</td>
<td>Lens Zoom</td>
<td>Stepper</td>
</tr>
<tr>
<td>5</td>
<td>Servo</td>
<td>Lens Iris</td>
<td>Lens Iris</td>
<td>Stepper</td>
</tr>
<tr>
<td>6</td>
<td>Servo</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Lens Focus</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Lens Zoom</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Lens Iris</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. If you changed the low-level settings, power cycle and re-load the head.
6. A control input (for example FOCUS) needs to be assigned to the lens axis, using \texttt{GENERAL SETUP > INPUTS SETUP > SET CONTROLLER}. Assign the lens motor axes to the desired control input, for example \texttt{FOCUS CON: FOCUS}. Note that the motor name will only be displayed if the axes names have been assigned to match the head in use, using \texttt{GENERAL SETUP > AXES SETUP > SET AXIS NAME}, and that the control input name (for example \texttt{FOCUS CON}) will vary between controller panels.

7. You must also set the input method to suit the type of input, for example you should set a zoom rocker to Speed-boat, using \texttt{GENERAL SETUP > INPUTS SETUP > SET INPUT METHOD}.

8. Use \texttt{GENERAL SETUP > AXES SETUP > SET SOFT LIMITS} to check the soft limits of the lens. The values for each lens axis should be (approximately):

   Upper: 65535
   Lower: 0

9. The linearity of the control input can be modified to facilitate smooth control of the lens axes, using \texttt{GENERAL SETUP > INPUTS SETUP > SET INPUT EXP}.

10. If it is required that one of the lens axes is given external control (for example iris) then the \texttt{HEAD AXIS TYPE} should be changed back to \texttt{SERVO}, see steps 4-5.
Low level settings

Caution
The low-level factory settings affect the motors in the head. These should only be changed under instruction from an MRMC engineer, as using the wrong settings can in some cases damage the motors.

Engineering mode:
GENERAL SETUP > LOW LEVEL SETUP

You specify the low level settings for each axis independently. Descriptions of the low level options are given below.

Current limits

Engineering mode:
GENERAL SETUP > LOW LEVEL SETUP > SET CURRENT LIMITS

If the head has servo motor (or PWM servos) control functionality then you can set the maximum current that a servo motor can draw before it trips. Typical values are:

Ulti-head Pan motor: 8.00A
Ulti-head Tilt motor: 4.00A
Lens control motor: 1.00A

Temperature limits

Engineering mode:
GENERAL SETUP > LOW LEVEL SETUP > SET TEMP LIMITS

Some heads have servo motor amplifiers with temperature sensing to protect against overheating. You can Enable or Disable this protection mechanism for each axis. Heads and/or axes without this feature will not be affected by this setting; it currently only applies to the Ulti-box, as found on the Ulti-head and some SFH-50 heads.
**PID system motor tunings**

Engineering mode:

```
GENERAL SETUP > LOW LEVEL SETUP > SET MOTOR TUNINGS > (Axes)
PRO
DER
INT
```

The motor drives in the head use a PID loop (Proportional, Integral, Derivative) to maintain motor position. The three tuning parameters for these control loops can be adjusted to change the response of the servo motor (or PWM servo motor). It is not recommended that you change these unless instructed to by an MRMC engineer or you are familiar with PID control theory. Typical values are:

- **PRO**: 30
- **DER**: 20
- **INT**: 20

**Motor frequency and polarity**

Engineering mode:

```
GENERAL SETUP > LOW LEVEL SETUP > SET MOTOR CONTROL
```

There are four different motor drive options for the servo motor axes:

- 80KHz Uni-Polar
- 20KHz Uni-Polar
- 80Khz Bi-Polar
- 20KHz Bi-Polar

20KHz Uni-Polar is the default value, suitable for all motors supplied with the head. Contact Mark Roberts Motion Control for assistance with selecting the control option for motors not supplied with the Head.

---

Caution

Selection of an incorrect drive option may damage the motor.
**Maximum error**

Engineering mode:
GENERAL SETUP > LOW LEVEL SETUP > SET MAX ERROR

You can set the maximum amount of position error that is allowed for each axis before the motor trips out. The maximum position error is the difference between the desired motor position and the actual motor position, beyond which the axis will trip.

A larger maximum error allows more slack in the system, making it less likely that a motor will trip out during high-acceleration moves and sudden direction changes. A large maximum error value is suitable for high-speed single-pass shots, as it makes an axis less likely to trip out during the move.

A smaller maximum error allows less slack in the system, making it more likely that a motor will trip out during a high-speed move. A small maximum error can be useful for multi-pass shots, as it puts constraints on how far the actual movement can vary from one pass to the next. A tripping axis can alert you to move discrepancies and remind you to adjust the motor tunings (PID system motor tunings on page 50) if, for example, you change the camera speed or the load on the camera platform by a large amount.

**Head axes type**

Engineering mode:
GENERAL SETUP > LOW LEVEL SETUP > SET HEAD AXES TYPE

Different heads have different motor configurations. The hardware in the head can support a range of configurations and this setup can vary between systems. These settings allow the firmware to be set up for a particular head motor configuration.

**SERVO**: Integrated brushed DC motor amplifier. This is used on the Ulti-head, and the Ulti-box version of the SFH-50.

**STEPPER**: Stepper motor (step and direction). This is used on the AFC 100 and AFCH 100 heads, SFH-30 head, and the Quad-box and Octo-box versions of the SFH-50.

**STEPPER + FB**: Stepper motor with encoder position feedback.

**D to A**: (Digital to Analog) Analog Voltage proportional to position error. This is used for the Canon analog lens.
D to A + FB: (Digital to Analog) Analog Voltage proportional to position error with encoder position feedback.

LENS IRIS: Digital lens iris control. This is used for Preston lens control motors, and for the Canon and Fujinon digital lenses.

LENS FOCUS: Digital lens focus control. This is used for Preston lens control motors, and for the Canon and Fujinon digital lenses.

LENS ZOOM: Digital lens zoom control. This is used for Preston lens control motors, and for the Canon and Fujinon digital lenses.

VEL OUTPUT: For an analog head motor. The output value is a function of the commanded velocity. The faster you want to go, the higher the voltage output. There is no position feedback so it is only for live manual control.

CAN: Controller Area Network brushless DC motor amplifier. You use this if you have an external motor amplifier that supports CANopen protocol. This is used in the AFC 180 head.

ROBOT: (Not operational in this version.)

PWM SERVO: External brushed Pulse Width Modulation DC motor amplifier with encoder feedback.

**Encoder Safety**

Engineering mode:
GENERAL SETUP > LOW LEVEL SETUP > SET ENCODER SAFETY

This feature detects encoder feedback failure, which can result in a run-away head. You can set the value to ON or OFF for each axis. This only applies to motors with encoders; that is, servo or PWM servo motors. If an encoder fails, the controller displays the message:

COMMS FAULT
DETECTED!!!
POWER CYCLE
THE HEAD

To recover from this error you must unplug the power lead from the head, plug it back in, and then reload and re-zero the head.
Axes home type

Engineering mode:
HOME AXES > SET HOME AXIS TYPE.

There are five types of homing:

- **DIRECT** - The axis will be zeroed at its current location (equivalent to **DIRECT ZERO**). You use this method for any axes that don't have a built-in physical home position such as an optical homing sensor, magnetic homing sensor, or hardware limit to its range of movement. This setting is typically used for focus rings that have a slip clutch instead of hard stops.

- **MAGNETIC** - The axis will rotate to find its magnetic home sensor and use that as the home position.

- **VANE** - A 180° vane and optical sensor are used. The axis will rotate to find the edge of the vane and use that as the home position.

- **HARD-LIMIT** - You use this if you have a Lens Control Motor (LCM) driving a lens axis that has a hard physical limit, such as a zoom ring. The axis will rotate to find the hard limits (one at each end of travel of the lens ring), record the axis positions, and use this information to zero the lens at the lower end and set the soft limits. You use this option in combination with the Engineering menu option HOME AXES > SET HOMING POWER. Too little power will fail to move a stiff lens ring; too much power will cause the motor gear to jump out of mesh when it pushes against the physical end of travel.

- **SERIAL LENS** - The controller will exercise the lens to find its limits, and then set those as the soft limits.
Head communication statistics

Engineering mode:
DIAGNOSE AXES > HEAD COMMS

If you are using a serial connection between the controller and the head (via the SERIAL A connector), the statistics for the communication are displayed. The values are as follows:

- **UPTIME** – The amount of time the controller has been powered up.
- **BUFFER FAIL** - The number of buffer failures.
- **BUFFER OVER** - The number of buffer overruns.
- **BUFFER UNDR** - The number of buffer underruns.
- **PACKET FAIL** - The number of packets that were corrupted.
- **ABSENT PKTS** - The number of packets that have gone missing.

Wireless communication

For information on using wireless communication between MRMC controllers and heads, contact Mark Roberts Motion Control.
Chapter 5  Managing settings and firmware with a Windows PC

Introduction to the MSA Ethernet Archiver and MSA Ethernet Firmware Updater

You can use a Windows PC connected to your MSA-20 Handwheels via an Ethernet cable to help manage the settings and firmware on your MSA-20 Handwheels. To do this you download and install the following two applications from Mark Roberts Motion Control:

- **MSA Ethernet Archiver**, for backing up and restoring your MSA-20 Handwheels settings. You can also send the backup file to Mark Roberts Motion Control to help troubleshoot a problem with your controller. Note that this application does not back up or restore moves.

- **MSA Ethernet Firmware Updater**, for updating the firmware in your MSA-20 Handwheels, or for configuring the MSA-20 Handwheels for use with a different head or different type of link to the head.

When you use either of the above applications the MSA-20 Handwheels unit acts a slave device responding to requests from the PC.

In the MSA-20 Handwheels, the controller settings and firmware are independent. They are stored in different locations and you manage them with the different applications listed above. When you power up the controller the firmware refers to the stored settings, and these settings then become visible in the MSA-20 Handwheels menus.

When you update the firmware, the existing settings in the MSA-20 Handwheels are unaffected but you might need to specify additional settings for any new menu options that don’t yet have their settings stored in the MSA-20 Handwheels. Nevertheless, it is safe practice to back up your settings before performing any major updates on your controller.

If you update the firmware to use different head, you will also need to either load a new settings file suitable for the new head (the recommended option) or else manually adjust many of the settings in the controller to cater for the new head.
The MSA Ethernet Archiver and MSA Ethernet Firmware Updater require firmware version MSA-21 v6.00 or later in your MSA-20 Handwheels. The firmware version is displayed on the controller screen when you first power up the system. If you have a version earlier than 6.00 then you must first update your firmware with a PC using the older serial-based application **MSA Move Archiver and Re-Flash Utility**, in combination with a Serial (RS232) connection. For assistance contact Mark Roberts Motion Control; you will also need the `.btl` file described in *Obtaining the .btl firmware file for your MSA-20 Handwheels* on page 58. After updating to MSA-21 v6.00 or later you can manage the settings and firmware in your MSA-20 Handwheels using the Ethernet methods described in this chapter.

**General procedure**

1. Download and install the applications and files that you will need. See: 
   *Downloading and installing the MSA Ethernet Archiver and MSA Ethernet Firmware Updater* on page 57
   *Obtaining the .btl firmware file for your MSA-20 Handwheels* on page 58.

2. Adjust the network settings on the PC so the archiver and firmware updater can communicate directly with the MSA-20 Handwheels over the Ethernet cable. See: 
   *Adjusting the PC network settings* on page 59.

3. Back up or restore the settings in your MSA-20 Handwheels as required. See: 
   *Using the MSA Ethernet Archiver* on page 62.

4. Update the firmware in your MSA-20 Handwheels as required. See: 
   *Using the MSA Ethernet Firmware Updater* on page 64.

5. When you are done using the archiver and/or firmware updater, revert the network settings on the PC to their original state so you have normal networking and internet access again. See: 
   *Adjusting the PC network settings* on page 59.
Downloading and installing the MSA Ethernet Archiver and MSA Ethernet Firmware Updater

1. Using a web browser on the PC, go to the Resources - Downloads section of the MRMC web site:

   http://www.mrmoco.com/resources/downloads

2. In the Software section of the web page, click on the MSA Ethernet Archiver to download it to your PC.

3. In the Software section of the web page, click on the MSA Ethernet Firmware Updater to download it to your PC.

4. On your PC, start a file browser (Windows Explorer) and point it to the location into which you downloaded the files, typically:

   C:\Users\Username\Downloads

   The files are:
   MSA Ethernet Archiver.exe
   FirmwareUpdater.exe

5. The MSA Ethernet Firmware Updater (FirmwareUpdater.exe) does not require any installation; you just run it from its existing location when needed, as described in Using the MSA Ethernet Firmware Updater on page 64. However, you need to install the MSA Ethernet Archiver before you can use it. To install it, double-click on the downloaded file:

   MSA Ethernet Archiver.exe

6. Follow the instructions on the PC screen to install the MSA Ethernet Archiver software.
Obtaining the .btl firmware file for your MSA-20 Handwheels

To update the firmware in your MSA-20 Handwheels you use the MSA Ethernet Firmware Updater to load a new .btl file into the MSA-20 Handwheels. To find out which .btl file you need and to get the file, contact Mark Roberts Motion Control. The choice of .btl file depends on the following, and you will need to supply this information to Mark Roberts Motion Control:

- Which controller you are using (MSA-20 Handwheels).
- Which head you want to use with the controller, and which board is installed in the head: Quad, Hex, Octo, or Ulti.
- Which communication method you want to use between the controller and the head: Ethernet or Serial.

The file will have a name similar to:

```
MSA21_Hex_II_Ether_mini_msa_ether.btl
```

When you get the .btl file from Mark Roberts Motion Control, put it into a convenient location on your Windows system, such as the Windows Desktop or C:\Users\User Name\Downloads. You will use the .btl file in Using the MSA Ethernet Firmware Updater on page 64.

Caution

If you have Flair Motion Control Software installed on your PC, note that the .btl files in folder C:\Flair\Flair6\Btls are for heads only — not for controllers. Do not use any of the .btl files in this folder to update your controller, or else you will erase the existing firmware in the controller and have to install it again from scratch using a Serial cable in combination with the old MSA Move Archiver and Re-Flash Utility.
Adjusting the PC network settings

After you have downloaded and installed the MSA Ethernet Archiver and/or MSA Ethernet Firmware Updater and .btl file, but before using these programs to communicate with the MSA-20 Handwheels, you need to adjust the network settings on the PC so it can communicate with the MSA-20 Handwheels directly over the Ethernet cable. You need to do the following:

- Temporarily disable your Wi-Fi network connection, if you are using one (so that the MSA Ethernet software does not try to use it).
- Assign a temporary static IP address to the physical Local Area Connection, which uses the Ethernet cable attached to the MSA-20 Handwheels.

The procedure for Windows 7 is as follows. Other versions will be similar.

1. Right-click on the Networking icon ( ) at the bottom of the Windows Desktop and in the pop-up menu choose Open Network and Sharing Center.
2. In the Network and Sharing Center window, click on Change adapter settings.
3. Right-click on the Wireless Network Connection button and in the pop-up menu click on Disable.
4. Still in the Network and Sharing Center window, right-click on Local Area Connection and in the pop-up menu choose Properties.
5. In the Local Area Connection Properties pop-up that appears, on the Networking tab, switch on and select **Internet Protocol Version 4 (TCP/IPv4)** then click on **Properties** to see the IP address settings. For example:
6. Make a note of the existing settings displayed on your PC, including the button setting and numbers, if any, so you can return to the same settings later.

7. Click on **Use the following IP address**, enter the numbers shown in the above screen shot, and click on **OK**. Confirm that you want to save the settings if you are prompted to do so, then **Close** the Local Area Connection Properties and Network and Sharing Center.
Using the MSA Ethernet Archiver

1. Unplug power cable from the MSA-20 Handwheels.
2. If you haven't already done so, connect the MSA-20 Handwheels to your PC using an Ethernet cable.
3. If you haven't already done so, adjust the Network settings on your PC (that is, turn off Wi-Fi and assign a static IP address to the cabled Ethernet connector) so that the PC and MSA-20 Handwheels can communicate. Details are in Adjusting the PC network settings on page 59.
4. Start the MSA Ethernet Archiver in your PC, by using the Windows Start menu option All Programs > MSA Ethernet Archiver > MSA Ethernet Archiver.

The MSA Ethernet Archiver is displayed on the computer screen, and automatically starts searching for the MSA-20 Handwheels.

5. With the BOOT MODE switch on the MSA-20 Handwheels in normal (Up) position for stand-alone operation, power up the MSA-20 Handwheels by plugging in the power cable.

(You can plug the power cable into the controller before starting the MSA Ethernet Archiver if you want, as long as you haven’t pressed the SELECT knob yet and the controller is still waiting for you to load the head.)

The controller starts up and automatically establishes an Ethernet connection to the PC, and the MSA Ethernet Archiver will then automatically find the controller on the network. When this happens, the MSA-20 Handwheels displays the message: ETHERNET ARCHIVER. The MSA Ethernet Archiver automatically downloads
the settings from the controller and into application memory, and displays the message: MSA found, settings received.

6. To save the MSA-20 Handwheels settings from application memory to a file on your PC, click on the Archive Settings button and in the file browser that appears specify a location and name for the settings file and click on OK.

or...

To restore the settings from a previously saved settings file into the controller, use the Browse button to find and select the relevant .set file on your PC, then click on the Load Settings button.
Using the MSA Ethernet Firmware Updater

Before doing this procedure make sure you have the .btl file that you will need (see page 58).

1. Unplug power cable from the MSA-20 Handwheels.

2. If you haven’t already done so, connect the MSA-20 Handwheels to your PC using an Ethernet cable.

3. If you haven’t already done so, adjust the Network settings on your PC (that is, turn off Wi-Fi and assign a static IP address to the cabled Ethernet connector) so that the PC and MSA-20 Handwheels can communicate. Details are in Adjusting the PC network settings on page 59.

4. Start the MSA Ethernet Firmware Updater in your PC, either by double-clicking on the FirmwareUpdater.exe file on the Desktop or by navigating to this file in a file browser (such as Windows Explorer, typically pointing to C:\Users\Username\Downloads) and double-clicking on the file.

   The Firmware Updater is displayed on the computer screen, and automatically starts searching for the MSA-20 Handwheels.

5. On the MSA-20 Handwheels:
   5.1 Make sure the BOOT MODE switch on the MSA-20 Handwheels is in normal (Up) position for stand-alone operation.
   5.2 Hold down the SELECT button with one hand.
   5.3 Plug the power cable into the controller with the other hand.
5.4 Release the **SELECT** button within 4 seconds. (If you hold it down longer the controller will start up normally without the Firmware Updater and you will need to unplug the power cable and try repeating step 5 again.)

The Firmware Updater should find the head and display the message: **Connection established. Waiting for BTL file.** The screen on the MSA-20 Handwheels remains blank.

6. In the Firmware Updater, click on the **Browse** button and in the file browser that appears specify the location and name of the .btl file that you got for the controller from Mark Roberts Motion Control.

7. In the Firmware Updater, click on the **Send Update** button.

When the Firmware Updater finishes updating the firmware it displays the message: **Update complete.**

**Hint**

The MSA Ethernet Firmware Updater will automatically close if you do not update the firmware within about two minutes, for security reasons. Updating the controller firmware is a major configuration change for the controller and it would be risky to leave the updater running on the system when you are not using it.
Returning the PC network settings to their original configuration

1. Right-click on the Networking icon ( ) at the bottom of the Windows Desktop and in the pop-up menu choose Open Network and Sharing Center.

2. In the Network and Sharing Center window, click on Change adapter settings.

3. If you were using Wi-Fi previously, right-click on the Wireless Network Connection button and in the pop-up menu click on Enable.

4. Still in the Network and Sharing Center window, right-click on Local Area Connection and in the pop-up menu choose Properties.
5. In the Local Area Connection Properties pop-up, Networking tab, switch on and select Internet Protocol Version 4 (TCP/IPv4) then click on Properties to see the IP address settings.

6. Enter your original settings and click on OK, then Close the then Close the Local Area Connection Properties and Network and Sharing Center.
Chapter 6 Setting up the MSA-20 Handwheels unit as a mimic device in Flair

If you use the MSA-20 Handwheels with Flair Motion Control Software running on a PC, the Handwheels operate as a slave mimic device. That is, you can use the wheels to control axes in Flair but the firmware built into the MSA-20 Handwheels becomes non-functional, as the system is controlled by Flair.

You can still use the **DIRECTION** and **SCALE** switches and knobs on the MSA-20 Handwheels, and you can use the **BACK** button to toggle the control for the third mimic axis between the third handwheel and whatever device is plugged into the **ZOOM** port, such as a Zoom controller or FIZ pot.

---

Caution

The **E-STOP** and **CAMERA** buttons on the MSA-20 Handwheels are non-functional in Flair mode because these facilities are under Flair control.

To connect the MSA-20 Handwheels to the Flair PC you use an Ethernet cable and Ethernet hub as shown in the next diagram.
Flair-Handwheel cable connections using Ethernet

Put the **BOOT MODE** switch to **Centre** position. Attach the power cables last.

- **3-hole plug, 24 Volts DC**
- **POWER IN**
- **ETHERNET**

See also *Back panel and accessories on page 124.*

- **24V 5A**
- **USB**
- **ETHETERNET**
- **Ethernet hub**
- **PC running Flair Motion Control Software.**

The head and controller both use the same type of power supply brick.
System configuration and startup

Hint

When connecting a Flair laptop with the MSA-20 Handwheels using an Ethernet connection, you might need to temporarily disable the Wi-Fi connection on the laptop so that Flair does not try to use it to connect to the MSA-20 Handwheels. (In the laptop’s Network and Sharing Center, click on Change Adapter settings, right-click on Wireless Network Connection and in the pop-up menu choose Disable.)

You can add up to two mimic devices in Flair, which Flair refers to as MimicBoard1 and MimicBoard2. Each mimic device has eight mimic control axes allocated to it in Flair, and Flair automatically numbers these using the next available numbers. For example Mimic Axis 9, Mimic Axis 10, etc.

The procedure below tells you how to configure Flair to recognise the MSA-20 Handwheels.

1. Make sure the relevant cables are attached as described in the previous section except for the MSA-20 Handwheels power cable. You must start these procedures with the MSA-20 Handwheels switched off.

2. Edit the file C:\Flair\Flairx\Flair.ini. This file is a text file that you can edit with any text editor such as Notepad, either directly or by using the Flair menu option Help > View .ini File. You need to add or edit some lines in the file similar to the following lines.

   *NetworkBoards: 8
   *MimicBoard1: 8
   #*MimicBoard2: 9
   *NodeProgram8: Mimic6Ether_II.btl

The keywords used in the above table are described below:

- **NetworkBoards**: The number of network boards (nodes) in the system. You need to increase this by one (1) to cater for the new board in the MSA-20 Handwheels mimic device. For
example if you have a Milo that has seven network boards, increase the number here to 8 (eight).

- **MimicBoard1, *MimicBoard2**: Assigns each mimic board to an available node. You need to specify a node that is not already used by another board. In this example nodes 1 to 7 are already used by other boards so *MimicBoard1* is assigned to node 8. There is only one mimic device installed so *MimicBoard2* is commented out.

- **NodeProgram8**: For the node to which you assigned the mimic (node 8 in this case), add a reference to the .btl file that you want Flair to load into the mimic device on that node when starting up. The .btl file is already supplied with Flair so you don't need to copy or download it from elsewhere. Remember to save the file after you have edited it.

3. On the MSA-20 Handwheels, move the **BOOT MODE** switch to the Centre (Flair mode) position.

4. With the Windows PC running but with Flair not running, attach the power cables to the Handwheels, the head, and the RT-12 or RT-14 unit (if you are using one).

5. When the RT-12 or RT-14 unit has finished starting up (if you are using one), start Flair by double-clicking on the Flair icon on the Windows Desktop.

   At this point, ignore any Flair error messages and MSA-20 Handwheels LED lights.

6. In the Flair menu, click on **Setups > Network Setup**.

7. In the pop-up, click on the **Find** button.

8. In the Find results, find the IP address of the MSA-20 Handwheels (192.168.1.236 in this example), and copy it into the node that you assigned to the MSA-20 Handwheels mimic device (Node 8 in this example):
9. In the Network Setup pop-up, click on the buttons **Save**, **Apply**, and **Exit**.

10. Restart Flair.

    Flair should now automatically recognise the MSA-20 Handwheels and load the `.btl` file into them. When running as a mimic, the panel on the MSA-20 Handwheels displays something like the following:

    
    ![](image)

    
    **E.MimicII v: 6.11**  
    (C) MRMC 2016  
    **First 3 axes are using Encoders**

11. Check that Flair is receiving data from the encoders in the MSA-20 Handwheels by using Flair menu option **Setups > Test Mimic Inputs** and making sure that the relevant mimic axes numbers change when you move the handwheels:

    ![](image)
12. In the Flair window, right-click on one of the axes buttons along the top of the screen, such as Pan, and in the pop-up menu choose Axis Setup.

13. On the Control tab, specify which wheel you want to use to control this axis, by setting the Controller to the mimic axis that you want to use, for example Mimic 9:

![Mimic Settings](image)

(The mimic axis numbers are the same ones listed earlier in the Setups > Test Mimic Inputs pop-up.)

14. Specify the other Mimic Settings that you want to use for this control (in the same section of the pop-up), then click on Save, Apply, and Exit.

15. In the Flair window, right-click on one of the axes buttons along the top of the windows, such as Pan, and in the pop-up menu choose Mimic Setup. You can also access this through the menu option Mimic > Axis Mimic.

![Axis Mimic Setup](image)

16. Specify Live for the axes that you have assigned the handwheels to, then Apply. After you have tested the mimic operation you can use other settings; see the Flair manual for details.

Moving a handwheel should now move the associated axis and change the axis position numbers on the Flair screen. You can use the DIRECTION and SCALE switches and knobs on the MSA-20 Handwheels, and use the BACK button to toggle the third mimic axis between the third handwheel and whatever device is plugged into the ZOOM port, such as a Zoom controller or FIZ pot.
Subsequent sessions

Once you have configured Flair to work with the MSA-20 Handwheels, the start-up procedure for subsequent sessions is as follows:

1. Make sure all cables are attached except the power cable on the MSA-20 Handwheels.
2. Power up the Windows PC but do not start Flair yet.
3. Power up the MSA-20 Handwheels in Flair mode.
4. Start Flair.

When Flair starts it issues a reset, which is indicated by the RESET lights on all connected devices including the MSA-20 Handwheels.

The system is then booted, all attached devices show a flashing Green Running LED when they are receiving boot data and will flash at a constant 25Hz when up and running.

Once all the devices have been booted and Flair is running, the yellow Inhibit LEDs on all devices switch off.

5. Enable the mimic controls in Flair, either by right-clicking on the relevant axes buttons at the top of the Flair window and choosing Mimic Setup in the pop-up menu, or by using the main menu option Mimic > Axis Mimic.

Hint

Flair does not store the Mimic > Axis Mimic settings from one session to the next, so you need to do this step at the start of every session. This is for safety reasons, as it would be dangerous to start up a robotic system with the mimic devices in an unknown state and fully enabled.
Appendix 1  Menu reference

The collection of menu options that are available on your controller depends on which menu mode you are in: Broadcast, Film, or Engineering. To change modes, use the menu option CHANGE MODE. The controller remembers the current mode when you switch it off between sessions. The options are summarised in the following sections:

- **Film mode** on page 77
- **Engineering mode** on page 85

This Appendix describes the menu options in version **MSA-21 6.14** of the MSA-20 Handwheels unit firmware. The firmware version number is displayed on the screen when you first power up the controller in Normal mode or Flair mode. You can also inspect the version number by using Engineering menu option **DIAGNOSE AXES > VERSION INFO**.

You would not ordinarily use Broadcast mode on the MSA-20 Handwheels, as this unit has no buttons for storing static camera positions, so the Broadcast menu options are not listed here.

**Caution**

When you go into Engineering mode you are prompted for a four-digit password (which is 4217), as applying the wrong settings here can stop the system from working. You should only use Engineering mode if you are an experienced user and have requirements that cannot be satisfied by using options in Film mode. Make a note of any changes that you make so you can revert to the previous value if the system stops working.

The names of the controls, as they appear in the menu, can vary depending on which specific controller model you’ve got and how it has been configured for accessories. For example, the MSA-20 Handwheels unit is typically set up for the following controls:

- **WHEEL L** (Wheel, Left)
- **WHEEL F** (Wheel, Front)
- **WHEEL R** (Wheel, Right)
- **FOCUS** (Auxiliary Focus Control)
- **ZOOM** (Auxiliary Zoom control)
The menu listings in this section abbreviate the above list as “(Controls)” instead of repeating the entire list each time.

The names of the axes, as they appear in the menu, can vary in how they are assigned to the controls, depending on how the controller has been configured for your particular head, requirements, and preferences. The axes are typically:

- **PAN**
- **TILT**
- **ROLL**

The menu listings in this section abbreviate the above list as “(Axes)” instead of repeating the entire list each time.
# Film mode

<table>
<thead>
<tr>
<th>Menu sequence (Film mode)</th>
<th>Description and possible settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CAMERA SETUP</strong></td>
<td></td>
</tr>
<tr>
<td>FPS</td>
<td>Camera speed, in Frames Per Second. See page 17.</td>
</tr>
<tr>
<td>LPF</td>
<td>Lines Per Frame for the servo or stepper motors. See page 17.</td>
</tr>
<tr>
<td><strong>ENABLE</strong></td>
<td>The type of signal used to trigger the camera during playback. See page 18.</td>
</tr>
<tr>
<td>MOMENTARY</td>
<td></td>
</tr>
<tr>
<td>TIME-LAPSE</td>
<td></td>
</tr>
<tr>
<td>PULSE</td>
<td></td>
</tr>
<tr>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td><strong>CAM SYNC</strong></td>
<td>The connection to be used for the incoming sync signal, used to synchronise the movement of the head with the camera. See page 19.</td>
</tr>
<tr>
<td>INTERNAL</td>
<td></td>
</tr>
<tr>
<td>MSA GPI 1</td>
<td></td>
</tr>
<tr>
<td>MSA VIDEO HEAD</td>
<td></td>
</tr>
<tr>
<td>DISABLED</td>
<td></td>
</tr>
<tr>
<td><strong>SYNC TIMEOUT</strong></td>
<td>The number of seconds to wait for the synchronisation signal to start a move.</td>
</tr>
<tr>
<td>Menu sequence (Film mode)</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td><strong>GENERAL SETUP &gt; SET SOFT LIMITS &gt;</strong></td>
<td><strong>(Axes) SL</strong>&lt;br&gt;<strong>MAX</strong>&lt;br&gt;<strong>MIN</strong>&lt;br&gt;<strong>ENABLE</strong> or <strong>DISABLE</strong> the limits of travel for each axis, and specify those limits. The <strong>MAX</strong> value must be larger (or more positive) than the <strong>MIN</strong> value. See page 13.</td>
</tr>
<tr>
<td><strong>SET SCALES &gt;</strong></td>
<td><strong>(Axes) SCL</strong>&lt;br&gt;The amount of scaling to be applied to the axes. See page 34.</td>
</tr>
<tr>
<td><strong>SET DIRECTION &gt;</strong></td>
<td><strong>(Controls)</strong>&lt;br&gt;The direction in which the controls operate. See page 8.&lt;br&gt;<strong>FWD</strong> - Forward&lt;br&gt;<strong>OFF</strong> - Disabled.&lt;br&gt;<strong>REV</strong> - Reverse</td>
</tr>
<tr>
<td><strong>SET FEATHERING &gt;</strong></td>
<td><strong>(Axes)</strong>&lt;br&gt;The maximum deceleration an axis can have as it approaches a soft limit. See page 37.</td>
</tr>
<tr>
<td><strong>SET INPUT SCALE % &gt;</strong></td>
<td><strong>(Controls)</strong>&lt;br&gt;The amount of scaling to be applied to the controls. See page 34.</td>
</tr>
<tr>
<td><strong>SET MAX ACCEL % &gt;</strong></td>
<td><strong>(Axes)</strong>&lt;br&gt;The maximum allowed acceleration and deceleration. See page 35.</td>
</tr>
<tr>
<td>Menu sequence (Film mode)</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td><strong>SET GOTO SPEED %</strong> &gt; (Axes)</td>
<td>The speed of the axes, as a percentage of top speed, when going to the start of a move (in Film mode). See page 37.</td>
</tr>
<tr>
<td><strong>SET DAMPING %</strong> &gt; (Controls)</td>
<td>The amount of smoothing to be applied to the controls, to filter out sudden jerks and twitches. See page 34.</td>
</tr>
<tr>
<td><strong>SET INPUT EXP</strong> &gt; (Controls)</td>
<td>The sensitivity (exponential) gradient of the controls. See page 35.</td>
</tr>
<tr>
<td><strong>SET ZRS</strong> &gt; <strong>ZRS MASTER ZRS SCALE</strong> &gt; (Controls) <strong>ON/OFF</strong></td>
<td>Specify the parameters for the Zoom-Related Speed facility, whereby the head axes (usually pan and tilt) automatically slow down a proportionate amount when you are zoomed in. See page 36.</td>
</tr>
<tr>
<td>Menu sequence (Film mode)</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>GENERAL SETUP &gt; SET BACK-PAN &gt; BP BACK-PAN &gt; PAN AXIS</td>
<td>Link two axes so that when one rotates, the other compensates to keep the camera on target. See page 41.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The speed used when homing the axes, as a percentage of top speed.</td>
</tr>
<tr>
<td>SET AXIS HOME SPEED &gt; (Axes)</td>
<td>The amount of motor power to be used when homing the axes, as a percentage of maximum power.</td>
</tr>
<tr>
<td>HOME AXES &gt; ALL AXES</td>
<td>Zero the axes automatically, all at once or one at a time, using the homing facility if your head has it. See page 12.</td>
</tr>
<tr>
<td></td>
<td>(Axes)</td>
</tr>
<tr>
<td>SELECT AXIS &gt; (Axes)</td>
<td>Zero the axes manually, at their current position. The menu displays the status as each axis is zeroed. See page 11.</td>
</tr>
<tr>
<td>DIRECT ZERO ALL</td>
<td></td>
</tr>
<tr>
<td>Menu sequence</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td><strong>REC-PLAY AXES</strong> &gt; A→B WAYPOINT MOVE &gt; SET POSITIONS &gt; POS A</td>
<td>Create a move by defining its start and end points. See page 20.</td>
</tr>
<tr>
<td></td>
<td>POS B</td>
</tr>
<tr>
<td></td>
<td>SET MOVE DURATION &gt; MOVE SECONDS</td>
</tr>
<tr>
<td></td>
<td>SET A→B FAIRINGS &gt; UP FAIRING</td>
</tr>
<tr>
<td></td>
<td>DOWN FAIRING</td>
</tr>
<tr>
<td></td>
<td>GENERATE A→B MOVE</td>
</tr>
<tr>
<td></td>
<td>RUN GENERATED MOVE &gt; SELECT PLAY MOVE</td>
</tr>
<tr>
<td></td>
<td>PLAY OPTIONS</td>
</tr>
<tr>
<td></td>
<td>PLAYBACK SAME SPEED</td>
</tr>
<tr>
<td></td>
<td>PLAYBACK ANY SPEED</td>
</tr>
<tr>
<td></td>
<td>SET PLAYBACK TRIGGE &gt;</td>
</tr>
<tr>
<td></td>
<td>TEST the move that you created.</td>
</tr>
<tr>
<td></td>
<td>See page 21.</td>
</tr>
<tr>
<td></td>
<td>PLAYBACK TRIGGE &gt;</td>
</tr>
<tr>
<td></td>
<td>Trigger the start of playback (and subsequent replays) by using an external input device plugged into the GPIO 2 connector. See page 82.</td>
</tr>
<tr>
<td>Menu sequence (Film mode)</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>RECORD &gt; SELECT REC AXES &gt; (Axes)</td>
<td>Select which axes you want to include in the recording. See page 22.</td>
</tr>
<tr>
<td>RECORD</td>
<td>Record a move. See page 22.</td>
</tr>
<tr>
<td>PLAYBACK &gt; SELECT PLAY MOVE</td>
<td>Play back a move. See page 24.</td>
</tr>
<tr>
<td>PLAYBACK SAME SPEED</td>
<td>Play back a move with extra options. See page 26.</td>
</tr>
<tr>
<td>SET PLAYBACK TRIGGE &gt; INPUT:</td>
<td>Trigger the start of playback (and subsequent replays) by using an external input device plugged into the GPIO 2 connector. You can still use the SELECT button to trigger playback if you want. See page 128.</td>
</tr>
<tr>
<td>PLAYBACK ANY SPEED</td>
<td></td>
</tr>
<tr>
<td>MODIFY &gt; SELECT PLAY MOVE</td>
<td>Create a new move that is partially based on an existing move. See page 31.</td>
</tr>
<tr>
<td>SELECT MOD AXES &gt; (Axes)</td>
<td></td>
</tr>
<tr>
<td>Menu sequence</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>REC-PLAY AXES &gt; TIME-LAPSE &gt;</td>
<td>Run a move as normal but trigger the camera at regular time intervals during playback, instead of just once at the start of the move. See page 29.</td>
</tr>
<tr>
<td>SELECT TL PLAY MOVE</td>
<td></td>
</tr>
<tr>
<td>TL OPTIONS &gt; FRAMES</td>
<td></td>
</tr>
<tr>
<td>FRAME TIME TYPE</td>
<td></td>
</tr>
<tr>
<td>TL PLAYBACK</td>
<td></td>
</tr>
<tr>
<td>PAIR PRESETS&amp;MOVES</td>
<td>This only applies to the LFP and Mini MSA Controllers. Assign recorded moves to the Preset buttons. In Film mode you can then play a move by pressing the relevant Preset button. (In Broadcast mode the Preset buttons still invoke static camera positions).</td>
</tr>
<tr>
<td>DELETE &gt; DELETE MOVES</td>
<td>Delete one or more moves. See page 33.</td>
</tr>
<tr>
<td>DELETE ALL MOVES</td>
<td>Delete all stored moves.</td>
</tr>
<tr>
<td>Menu sequence</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td><strong>DIAGNOSE</strong></td>
<td></td>
</tr>
<tr>
<td>AXES**</td>
<td>(Controls) the current values being output by the controls, updated continuously as you use the controls.</td>
</tr>
<tr>
<td><strong>INPUT</strong></td>
<td></td>
</tr>
<tr>
<td><strong>VALUES</strong></td>
<td>(Axes) the current values of the axes, updated continuously as you move the axes.</td>
</tr>
<tr>
<td><strong>AXIS</strong></td>
<td></td>
</tr>
<tr>
<td><strong>POSITIONS</strong></td>
<td>(Axes) three digits that indicate the state of the hard limit and datum (home position) switches on an axis, updated as you move the controls. The first digit is the limit status: 1 (one, open) when an axis reaches either one of its hard limit switches, and 0 (zero, closed) otherwise. The second digit is the datum status. For a head with homing fins it is 0 (closed) on one side of the home position and 1 (open) on the other side. For a head with a magnetic homing switch it is 1 (open) at the home position and 0 (closed) on either side of it. The third digit is not currently used.</td>
</tr>
<tr>
<td><strong>LIMIT</strong></td>
<td></td>
</tr>
<tr>
<td><strong>INPUTS</strong></td>
<td>(Axes) three digits that indicate the state of the hard limit and datum (home position) switches on an axis, updated as you move the controls. The first digit is the limit status: 1 (one, open) when an axis reaches either one of its hard limit switches, and 0 (zero, closed) otherwise. The second digit is the datum status. For a head with homing fins it is 0 (closed) on one side of the home position and 1 (open) on the other side. For a head with a magnetic homing switch it is 1 (open) at the home position and 0 (closed) on either side of it. The third digit is not currently used.</td>
</tr>
<tr>
<td><strong>CHANGE</strong></td>
<td></td>
</tr>
<tr>
<td><strong>MODE</strong></td>
<td>(Axes) three digits that indicate the state of the hard limit and datum (home position) switches on an axis, updated as you move the controls. The first digit is the limit status: 1 (one, open) when an axis reaches either one of its hard limit switches, and 0 (zero, closed) otherwise. The second digit is the datum status. For a head with homing fins it is 0 (closed) on one side of the home position and 1 (open) on the other side. For a head with a magnetic homing switch it is 1 (open) at the home position and 0 (closed) on either side of it. The third digit is not currently used.</td>
</tr>
<tr>
<td><strong>FILM</strong></td>
<td>Change the operating mode. Engineering mode prompts you for a four-digit password.</td>
</tr>
<tr>
<td><strong>MODE</strong></td>
<td></td>
</tr>
</tbody>
</table>
**Engineering mode**

Caution

Engineering mode is only for advanced users, as applying the wrong settings here can stop the system from working. When you go into Engineering mode you are prompted for a four-digit PIN, which is 4217. Apply the settings in Engineering mode carefully, and make a note of the changes so you can revert to the previous settings if the system stops working.
<table>
<thead>
<tr>
<th>Menu sequence (Engineering mode)</th>
<th>Description and possible settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CAMERA SETUP</strong> &gt; <strong>FPS</strong></td>
<td>Camera speed, in Frames Per Second. See page 17.</td>
</tr>
<tr>
<td><strong>LPF</strong></td>
<td>Lines Per Frame for the servo or stepper motors. See page 17.</td>
</tr>
<tr>
<td><strong>ENABLE</strong></td>
<td>The type of signal used to trigger the camera during playback. See page 18.</td>
</tr>
<tr>
<td></td>
<td><strong>MOMENTARY</strong></td>
</tr>
<tr>
<td></td>
<td><strong>TIME-LAPSE</strong></td>
</tr>
<tr>
<td></td>
<td><strong>PULSE</strong></td>
</tr>
<tr>
<td></td>
<td><strong>CONTINUOUS</strong></td>
</tr>
<tr>
<td>Menu sequence (Engineering mode)</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td><strong>CAMERA SETUP</strong> &gt; CAM SYNC</td>
<td>The connection to be used for the incoming sync signal, used to synchronise the camera with the movement of the head. See page 19.</td>
</tr>
<tr>
<td><strong>INTERNAL</strong></td>
<td></td>
</tr>
<tr>
<td><strong>MSA GPI 1</strong></td>
<td></td>
</tr>
<tr>
<td><strong>MSA VIDEO</strong></td>
<td></td>
</tr>
<tr>
<td><strong>HEAD</strong></td>
<td><strong>DISABLED</strong></td>
</tr>
<tr>
<td><strong>SYNC TIMEOUT</strong></td>
<td>The number of seconds to wait for the synchronisation signal to start a move.</td>
</tr>
<tr>
<td><strong>GENERAL SETUP</strong> &gt; AXES SETUP &gt; SET SOFT LIMITS &gt; (Axes) SL</td>
<td><strong>ENABLE</strong> or <strong>DISABLE</strong> the limits of travel for each axis, and specify those limits. The <strong>MAX</strong> value must be larger (or more positive) than the <strong>MIN</strong> value. See page 13.</td>
</tr>
<tr>
<td><strong>MAX</strong></td>
<td></td>
</tr>
<tr>
<td><strong>MIN</strong></td>
<td></td>
</tr>
<tr>
<td><strong>SET SCALES</strong> &gt; (Axes) SCL</td>
<td>The amount of scaling to be applied to the output of the axes. See page 34.</td>
</tr>
</tbody>
</table>
### Menu sequence (Engineering mode)

<table>
<thead>
<tr>
<th>Description and possible settings</th>
</tr>
</thead>
</table>

| GENERAL SETUP > AXES SETUP (continued) > SET ENC RATIOS > RATIO | Specify the conversion factor to be used to convert encoder values to real-world values. This affects the numbers that are displayed for the axis positions (in DIAGNOSE AXES > AXIS POSITIONS) and the numbers that appear in exported moves. |
| SET DIRECTION > (Axes) | The direction in which the axes operate. This also determines the direction in which the axes position values increase, and (depending on the axis) determines which side or end of the axis is the Homing point (see page 117). Note that this option is different from the option GENERAL SETUP > INPUTS SETUP > SET INPUT DIR (page 8) which only changes the polarity of the Controls without changing the axis numbering direction or the Homing behaviour. FWD - Forward OFF - Disabled REV - Reverse | The maximum allowed speed for each axis. |
### Menu sequence (Engineering mode)

<table>
<thead>
<tr>
<th><strong>Axes Setup</strong> (continued)</th>
<th><strong>Axes</strong></th>
<th><strong>Axes</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Set Max Accel</strong> &gt;</td>
<td>(Axes)</td>
<td>The maximum possible acceleration that you want to use for each axis.</td>
</tr>
<tr>
<td><strong>Set Max Accel %</strong> &gt;</td>
<td>(Axes)</td>
<td>The maximum allowed acceleration for each axis, as a percentage of the maximum possible acceleration that you have specified with <code>Set Max Accel</code>.</td>
</tr>
<tr>
<td><strong>Set Feathering</strong> &gt;</td>
<td>(Axes)</td>
<td>The maximum deceleration each axis can have as it approaches a soft limit. See page 37.</td>
</tr>
<tr>
<td><strong>Set Goto Speed %</strong> &gt;</td>
<td>(Axes)</td>
<td>The speed of each axes, as a percentage of top speed, when going to the start of a move. See page 37.</td>
</tr>
<tr>
<td><strong>Set Axis Name</strong> &gt;</td>
<td><strong>Axis1</strong> <strong>Axis2</strong>...</td>
<td>Assign a meaningful name to each axis, such as Pan, Tilt, Roll, Focus, Zoom, etc. The assigned name is then used elsewhere in the menus (in place of <code>Axis1</code>, <code>Axis2</code>, etc.), and in archived settings.</td>
</tr>
<tr>
<td><strong>Set Axis Type</strong> &gt;</td>
<td>(Axes)</td>
<td>Specify the type of axis, for each axis. See page 39.</td>
</tr>
<tr>
<td><strong>Set Backlash</strong> &gt;</td>
<td>(Axes)</td>
<td>Specify the amount of backlash for each axis.</td>
</tr>
<tr>
<td>Menu sequence (Engineering mode)</td>
<td>Description and possible settings</td>
<td></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>GENERAL SETUP &gt;</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SETUP (continued)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AXES SETUP &gt;</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SET INTERNAL AXES &gt;</strong></td>
<td>Specify which axis control data is to be sent out through the GPO pins on the <strong>EXPANSION/PAN BARS</strong> connector, to make a slave stepper motor plug-in perform the same move as one of the controller’s other axes. See page 39.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>INPUTS SETUP &gt;</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SET CONTROLLER &gt;</strong></td>
<td>(Controls) Assign one or more control inputs to each axis.</td>
<td></td>
</tr>
<tr>
<td><strong>SET DAMPING &gt;</strong></td>
<td>(Controls) The amount of smoothing to be applied to the controls, to filter out sudden jerks and twitches. The <strong>SET DAMPING %</strong> option in Film mode is a percentage of the amount that you set here, inverted so that 0% damping = no smoothing (very responsive), and 100% damping = heavily smoothed (very sluggish). See page 34.</td>
<td></td>
</tr>
<tr>
<td><strong>SET DAMPING % &gt;</strong></td>
<td>(Controls) The amount of smoothing to be applied to the controls, to filter out sudden jerks and twitches. See page 34.</td>
<td></td>
</tr>
<tr>
<td><strong>SET INPUT SCALE % &gt;</strong></td>
<td>(Controls) The amount of scaling to be applied to the controls. See page 34.</td>
<td></td>
</tr>
<tr>
<td>Menu sequence (Engineering mode)</td>
<td>Description and possible settings</td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------</td>
<td></td>
</tr>
</tbody>
</table>
| **GENERAL SETUP** > **INPUTS SETUP** (continued) | **SET INPUT DIR** > (Controls) Set the direction in which the controls operate. See page 8.  
**FWD** - Forward  
**OFF** - Disable the control.  
**REV** - Reverse  
**SET INPUT EXP** > (Controls) The sensitivity (exponential) gradient of the controls: See page 35.  
**SET DIR SWITCHES** > (Controls) Assign the three **DIRECTION** switches (**FWD**, **OFF**, **REV**) on the controller to the controls.  
**SET SCALE SWITCHES** > (Controls) Assign the three **SCALE** switches (**X1**, **X2**, **X4**) to the controls.  
**SET SCALE POTS** > (Controls) Specify which controls are affected by the **SCALE** knobs on the controller, or by other potentiometer-based controls (“POTS”) that you plug into the controller. This only applies to basic pots which control electric voltage such as the **SCALE** knobs. It does not apply to knobs with encoders such as a **ZOOM** control which you assign to axes by using **GENERAL SETUP > INPUTS SETUP > SET CONTROLLER**.
<table>
<thead>
<tr>
<th>Menu sequence (Engineering mode)</th>
<th>Description and possible settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>GENERAL SETUP &gt; SETUP INPUT &gt; (Controls)</td>
<td>The type of behaviour for the control: Normal or Speedboat. See page 40.</td>
</tr>
<tr>
<td>SET INPUT METHOD &gt; (Controls)</td>
<td>The amount of control movement (away from some centre or zero position) that is required to make the head start to respond. See page 40.</td>
</tr>
<tr>
<td>SET INPUT DEADZONE &gt; (Controls)</td>
<td>Adjust scaling of a FIZ pot control so that the full range of the pot is mapped to the full range of its assigned axis. See page 121.</td>
</tr>
<tr>
<td>SET POT RANGE &gt; (Controls)</td>
<td>Adjust the Zoom-Related Speed facility, whereby the head axes (usually pan and tilt) automatically slow down a proportionate amount when you are zoomed in. See page 36.</td>
</tr>
<tr>
<td>BACK-PAN SETUP &gt; BP &gt; BP AXIS BP SCALE</td>
<td>Link two axes so that when one rotates, the other compensates to keep the camera on target. See page 41.</td>
</tr>
<tr>
<td>Menu sequence (Engineering mode)</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td><strong>GENERAL SETUP &gt; SERIAL SETUP &gt; MODE</strong></td>
<td>The mode and speed (in bits per second) to be used for the <strong>SERIAL B</strong> port on the controller. This is used by the legacy <strong>MSA Move Archiver and Re-Flash Utility</strong> running on a PC, and for outputting the control positions to a PC. See page 42.</td>
</tr>
<tr>
<td><strong>LAN SETUP &gt; SET MSA IP ADDRESS</strong></td>
<td>Specify the IP (Internet Protocol), SN (Subnet Mask), and GW (Gateway) addresses of the controller and head. See page 108.</td>
</tr>
<tr>
<td><strong>LAN SETUP &gt; SET HEAD IP ADDRESS</strong></td>
<td></td>
</tr>
<tr>
<td><strong>LAN SETUP &gt; PING HEAD</strong></td>
<td></td>
</tr>
<tr>
<td><strong>LAN SETUP &gt; FIND HEAD</strong></td>
<td></td>
</tr>
<tr>
<td>Menu sequence (Engineering mode)</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td><strong>GENERAL SETUP &gt; LOW LEVEL SETUP</strong></td>
<td><strong>SET CURRENT LIMITS</strong> &gt; (Axes) Low-level motor settings. These should only be changed under instruction from an MRMC engineer, as an incorrect setting can damage the motors. See page 49.</td>
</tr>
<tr>
<td></td>
<td><strong>SET TEMP LIMITS</strong> &gt; (Axes)</td>
</tr>
<tr>
<td></td>
<td><strong>SET MOTOR TUNINGS</strong> &gt; (Axes) <strong>PRO</strong> (Axes) <strong>DER</strong> (Axes) <strong>INT</strong></td>
</tr>
<tr>
<td></td>
<td><strong>SET MOTOR CONTROL</strong> &gt; (Axes)</td>
</tr>
<tr>
<td></td>
<td><strong>SET MAX ERROR</strong> &gt; (Axes)</td>
</tr>
<tr>
<td></td>
<td><strong>SET HEAD AXES TYPE</strong> &gt; (Axes)</td>
</tr>
<tr>
<td></td>
<td><strong>SET ENCODER SAFETY</strong> &gt; (Axes)</td>
</tr>
<tr>
<td>Menu sequence (Engineering mode)</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>HOME AXES &gt; ALL AXES &gt; (Axes)</td>
<td>Zero the axes automatically, all at once or one at a time, using the homing facility if your head has it. See page 12.</td>
</tr>
<tr>
<td>HOME AXES &gt; SELECT AXIS &gt; (Axes)</td>
<td></td>
</tr>
<tr>
<td>HOME AXES &gt; DIRECT ZERO &gt; (Axes)</td>
<td>Zero the axes manually, at their current position. The menu displays the status as each axis is zeroed. See page 11.</td>
</tr>
<tr>
<td>HOME AXES &gt; DIRECT ZERO ALL</td>
<td></td>
</tr>
<tr>
<td>HOME AXES &gt; SET AXIS HOME TYPE &gt; (Axes)</td>
<td>The type of homing to be used for each axis. See page 53.</td>
</tr>
<tr>
<td>HOME AXES &gt; SET AXIS HOME SPEED &gt; (Axes)</td>
<td>The speed used when homing the axes, as a percentage of top speed.</td>
</tr>
</tbody>
</table>
### Description and possible settings

<table>
<thead>
<tr>
<th>Menu sequence (Engineering mode)</th>
<th>Description</th>
<th>(continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HOME AXES</strong> &gt; <strong>POWER</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Axes)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### ZEROING METHOD

<table>
<thead>
<tr>
<th>ZEROING METHOD</th>
<th>Description and possible settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ZER OING</strong></td>
<td>Specify the type of zeroing/homing to be used when in Broadcast mode. Note that you cannot automatically home a lens ring that has a slip clutch, as this type does not have a hard end stop. You must zero such a ring/axis manually instead (using homing type <strong>DIRECT</strong>).</td>
</tr>
<tr>
<td><strong>DIRECT ZERO ALL</strong></td>
<td>Used automatically in Broadcast mode so you can zero the axes manually at their home positions.</td>
</tr>
</tbody>
</table>

**POWER**

- The amount of motor power to be used when homing each axis, as a percentage of maximum power. This is only used on axes that use a HARD-LIMIT homing type (see above). If the motor reaches the end of travel of a lens ring, the lens motor gear will jump out of mesh and homing will fail. The value is too high, the lens motor gear will jump out of mesh and homing will fail. If the value is too low for a stiff lens then the axis will fail to move.

**HOME AXES**

- The option **DIRECT ZERO ALL** is available in Broadcast mode while **HOME ALL AXES** is available in Engineering mode. The option **HOME ALL AXES** is available in broadcast mode so you can zero the axes manually at their current position.
<table>
<thead>
<tr>
<th>Menu sequence (Engineering mode)</th>
<th>Description and possible settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>REC-PLAY AXES WAYPOINT MOVE</td>
<td>Create a move by defining its start and end points.</td>
</tr>
<tr>
<td>SET POSITIONS &gt; POS A</td>
<td>See page 20.</td>
</tr>
<tr>
<td>SET POSITIONS &gt; POS B</td>
<td></td>
</tr>
<tr>
<td>SET MOVE DURATION &gt; MOVE SECONDS</td>
<td></td>
</tr>
<tr>
<td>SET A-&gt;B FAIRINGS &gt; UP FAIRING</td>
<td>Test the move that you created.</td>
</tr>
<tr>
<td>SET A-&gt;B FAIRINGS &gt; DOWN FAIRING</td>
<td>See page 21.</td>
</tr>
<tr>
<td>GENERATE A-&gt;B MOVE</td>
<td></td>
</tr>
<tr>
<td>RUN GENERATED MOVE &gt; SELECT PLAY MOVE</td>
<td></td>
</tr>
<tr>
<td>RUN GENERATED MOVE &gt; PLAY OPTIONS</td>
<td></td>
</tr>
<tr>
<td>RUN GENERATED MOVE &gt; PLAYBACK SAME SPEED</td>
<td></td>
</tr>
<tr>
<td>RUN GENERATED MOVE &gt; PLAYBACK ANY SPEED</td>
<td></td>
</tr>
<tr>
<td>RECORD &gt; SELECT REC AXES</td>
<td>Select which axes you want to include in the recording.</td>
</tr>
<tr>
<td>RECORD</td>
<td>See page 22.</td>
</tr>
<tr>
<td>RECORD</td>
<td>Record a move.</td>
</tr>
<tr>
<td>RECORD</td>
<td>See page 22.</td>
</tr>
<tr>
<td>Menu sequence (Engineering mode)</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------------------------</td>
</tr>
</tbody>
</table>
| REC-PLAY AXES > PLAYBACK > SELECT PLAY MOVE | Play back a move.  
See page 24. |
| PLAY OPTIONS > REPEATS REC. SPEED | Play back a move with extra options.  
See page 26. |
<p>| PLAYBACK SAME SPEED | |
| PLAYBACK ANY SPEED | |
| SET PLAYBACK TRIGGE &gt; INPUT: | Trigger the start of playback (and subsequent replays) by using an external input device plugged into the GPIO 2 connector. Possible INPUT settings are: |
| TRIG1 = GPI1 (pin 3) | |
| TRIG2 = GPI2 (pin 4) | |
| TRIG3 = GPI3 (pin 5) | |
| TRIG4 = GPI4 (pin 6) | |</p>
<table>
<thead>
<tr>
<th>Menu sequence (Engineering mode)</th>
<th>Description and possible settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>REC-PLAY AXES &gt; MODIFY &gt; SELECT PLAY MOVE</td>
<td>Create a new move that is partially based on an existing move. See page 31.</td>
</tr>
<tr>
<td></td>
<td>(Axes) RECORD MOD</td>
</tr>
<tr>
<td>TIME-LAPSE &gt; SELECT TL PLAY MOVE</td>
<td>Run a move as normal but trigger the camera at regular time intervals during playback, instead of just once at the start of the move. See page 29.</td>
</tr>
<tr>
<td>TL OPTIONS &gt; FRAMES</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FRAME TIME TYPE</td>
</tr>
<tr>
<td>TL PLAYBACK</td>
<td></td>
</tr>
<tr>
<td>PAIR PRESETS &amp; MOVES</td>
<td>This only applies to the LFP and Mini MSA Controllers. Assign recorded moves to the Preset buttons. In Film mode you can then play a move by pressing the relevant Preset button. (In Broadcast mode the Preset buttons still invoke static camera positions).</td>
</tr>
<tr>
<td>DELETE &gt; DELETE MOVES</td>
<td>Delete one or more moves. See page 33.</td>
</tr>
<tr>
<td>DELETE ALL MOVES</td>
<td>Delete all stored moves.</td>
</tr>
</tbody>
</table>
### Menu sequence (Engineering mode)

<table>
<thead>
<tr>
<th>Menu Sequence</th>
<th>Description and possible settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DIAGNOSE AXES &gt; INPUT VALUES</strong></td>
<td>(Controls) The current raw values being output by the controls, updated continuously as you use the controls. Some inputs use encoders and others use an analog Voltage. Encoder values vary between 0 and 65535, analog Voltage inputs vary between 0 and 255.</td>
</tr>
<tr>
<td><strong>INPUT POSITIONS</strong></td>
<td>(Controls) The input position is calculated from the input value after it has had the specified input method applied to it (Normal or Speedboat) which you set with <strong>GENERAL SETUP &gt; INPUTS SETUP &gt; SET INPUT METHOD</strong>, see page 40. Moving the control changes the raw input value, which in turn changes the corresponding control input position. The input position value has no position, speed, or acceleration limits applied.</td>
</tr>
<tr>
<td><strong>COMMAND POSITIONS</strong></td>
<td>(Controls) The command position is calculated from the input position after it has had the scaling, damping, input exponential, and position, speed, and acceleration limits applied. The command position is sent to the head as the target position for the motor. The difference between the command position and the actual measured motor position is what the PID system uses to generate the motor movement.</td>
</tr>
<tr>
<td>Menu sequence (Engineering mode)</td>
<td>Description and possible settings</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>DIAGNOSE AXES &gt; AXIS POSITIONS &gt; (Axes)</td>
<td>The current values of the axes, updated continuously as you move the axes, in real world units such as degrees. You can adjust the conversion between encoders and reality with <strong>GENERAL SETUP &gt; AXES SETUP &gt; SET ENC RATIOS</strong>.</td>
</tr>
<tr>
<td>AXIS VELOCITIES &gt; (Axes)</td>
<td>The current velocities of the axes, updated continuously as you move the head.</td>
</tr>
<tr>
<td>A2D VALUES</td>
<td>The low-level values being output from the controls, immediately after conversion from analog to digital, without any remapping or filtering. This is only used by MRMC engineers.</td>
</tr>
<tr>
<td>INPUTS AND BUTTONS</td>
<td>The current statuses of the switches and buttons on the controller.</td>
</tr>
</tbody>
</table>
**Menu sequence (Engineering mode)**

<table>
<thead>
<tr>
<th>TEST OUTPUTS</th>
<th>ENABLE1</th>
</tr>
</thead>
</table>
|pecified by the controller panel or the LEDs on devices that are attached to the controller. Highlighting an ENABLE indicator in the menu will cause the corresponding LED to light. If it doesn’t then there is a fault with the LED’s connection. The LEDs for additional control inputs (ENABLE4 and ENABLE 5 for plug-in mimic devices such as pan bars and FIZ pots) will only light if the corresponding device is plugged into the controller. Note that not all products have ENABLE LEDs.

| TEST SERIAL | The serial ports and the controller can be tested to ensure correct communication. Alphabetic characters are sent out on each port and any received characters are displayed. Loop back testing is the best method of testing, which is where the transmit pin is connected to the receive pin, so all sent characters are echoed back to the display. If the head is connected then this test will fail.

<p>| HEAD COMMS | Statistical information on communications, if you are using a serial connection between the controller and the head. See page 54. |</p>
<table>
<thead>
<tr>
<th>Menu sequence (Engineering mode)</th>
<th>Description and possible settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RESTORE DEFAULTS</strong></td>
<td>Restores the controller to its factory default settings. Caution: This loses all stored data and custom settings. You should only use this option in extreme circumstances under the direction of an MRMC engineer, as it usually results in a system that does not work until you manually re-enter all the appropriate settings for your particular head. Make a backup copy of your settings first, using the procedures in Chapter 5.</td>
</tr>
<tr>
<td><strong>VERSION INFO</strong></td>
<td>Display the version number of various hardware and software components for the controller and attached head: SOFTWARE MSA BOARD MSA ISSUE MSA ID HEAD BOARD HEAD ISSUE HEAD ID</td>
</tr>
</tbody>
</table>
### LIMIT INPUTS
(Axes) Three digits that indicate the state of the hard limit and datum (home position) switches on an axis, updated as you move the controls. The first digit is the limit status: 1 (one, open) when an axis reaches either one of its hard limit switches, and 0 (zero, closed) otherwise. The second digit is the datum status. For a head with homing fins it is 0 (closed) on one side of the home position and 1 (open) on the other side. For a head with a magnetic homing switch it is 1 (open) at the home position and 0 (closed) on either side of it. The third digit is not currently used.

### ENCODER VALUES
(Axes) ENC The raw encoder values coming from the head, updated continuously as the head moves.

### AUTO ENABLE
(Axes) If an axes trips (for example from the position error exceeding the maximum allowed value) then the system will automatically re-enable the motor after a short delay. However, if the axis continues to trip then the auto-enable feature will turn off to protect the motor. Once the problem that caused the motor to trip has be fixed the auto-enable feature for that motor can be re-enabled here.

### Menu sequence (Engineering mode)

<table>
<thead>
<tr>
<th>Menu sequence (Engineering mode)</th>
<th>Description and possible settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIAGNOSE AXES &gt; HEAD DIAGNOSTICS &gt; LIMIT INPUTS</td>
<td>(Axes) Three digits that indicate the state of the hard limit and datum (home position) switches on an axis, updated as you move the controls. The first digit is the limit status: 1 (one, open) when an axis reaches either one of its hard limit switches, and 0 (zero, closed) otherwise. The second digit is the datum status. For a head with homing fins it is 0 (closed) on one side of the home position and 1 (open) on the other side. For a head with a magnetic homing switch it is 1 (open) at the home position and 0 (closed) on either side of it. The third digit is not currently used.</td>
</tr>
<tr>
<td>ENCODER VALUES</td>
<td>(Axes) ENC The raw encoder values coming from the head, updated continuously as the head moves.</td>
</tr>
<tr>
<td>AUTO ENABLE</td>
<td>(Axes) If an axes trips (for example from the position error exceeding the maximum allowed value) then the system will automatically re-enable the motor after a short delay. However, if the axis continues to trip then the auto-enable feature will turn off to protect the motor. Once the problem that caused the motor to trip has be fixed the auto-enable feature for that motor can be re-enabled here.</td>
</tr>
<tr>
<td>CHANGE MODE &gt; BROADCAST MODE</td>
<td>ENGINEERING MODE</td>
</tr>
<tr>
<td>ENGINEERING MODE</td>
<td>Change the operating mode. Engineering mode prompts you for a four-digit password.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Typical symptoms, causes, and actions

<table>
<thead>
<tr>
<th>Symptoms or message</th>
<th>Cause and/or action</th>
</tr>
</thead>
<tbody>
<tr>
<td>HEAD DID NOT LOAD</td>
<td>The MSA-20 Handwheels failed to load the operating system into the head.</td>
</tr>
<tr>
<td>HEAD NOT LOADED</td>
<td>Check that all cables are connected, and all devices have power.</td>
</tr>
<tr>
<td>LOAD FAIL</td>
<td>If you have connected more than one head, connected the MRMC system to another local network, or moved the controller and head between networks, check that correct LAN addresses have been entered in the controller. See Working with Local Area Networks on page 108.</td>
</tr>
<tr>
<td>FAILED TO LOAD HEAD</td>
<td>Check the order in which the devices are powering up. If you are using an Ethernet connection to the head, avoid powering the head from the power output socket on the controller in order to avoid powering up the two devices simultaneously (which can cause problems on small isolated Ethernet networks). Use an independent power source for each, and power up the head first. If you are using a Serial connection to the head, power up the controller first. Data corruption can also cause a failure to load the head. Use a shorter cable to improve the communication, and ensure the cable is not running near any high current devices.</td>
</tr>
<tr>
<td>FAILED TO INITIALIZE ETHERNET</td>
<td></td>
</tr>
<tr>
<td>Controls move in the wrong direction</td>
<td>Change the working direction of the controls to your preference (page 8).</td>
</tr>
<tr>
<td>Limits are being ignored or causing the</td>
<td>The axes have not been zeroed. You must do this at the beginning of each session just after you load the head (page 10).</td>
</tr>
<tr>
<td>head to oscillate when reached.</td>
<td></td>
</tr>
<tr>
<td>Symptoms or message</td>
<td>Cause and/or action</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Can’t set limits, or the head oscillates when you set a limit.</td>
<td>When you set soft limits (page 13) you must set the <strong>MAX</strong> limit to the higher (or more positive) axis value, and set the <strong>MIN</strong> limit to the lower (or more negative) value. After zeroing the axes (page 10), all the lens axes (focus, zoom, and iris) should have a <strong>MIN</strong> value of zero (0) and for these axes you should only change the <strong>MAX</strong> values. If you can only move the focus, zoom, or iris axis into negative values then it means you are using a lens with external motors, and that the axis value is increasing in the wrong direction on your particular rig. To cater for this, see Zeroing lens axes with external Lens Control Motors on page 117.</td>
</tr>
<tr>
<td>The head moves too slowly or too quickly when zoomed in.</td>
<td>The Zoom Related Speed (ZRS) feature automatically slows the live pan and tilt controls to cater for the narrow field of view when zoomed in. You can adjust the amount of slowing in the <strong>SET ZRS</strong> menu options (page 36).</td>
</tr>
<tr>
<td>The head moves more slowly when zoomed out.</td>
<td>You are using a lens with external motors, and the zoom axis value is increasing in the wrong direction on your particular rig. To cater for this, see Zeroing lens axes with external Lens Control Motors on page 117.</td>
</tr>
</tbody>
</table>
Move playback fails to start.

The option **CAMERA SETUP > CAM SYNC** is using a setting other than **DISABLED** and the controller has not yet received a sync signal from the camera (or external genlock system) to trigger the start of the move recording or playback.

Start the camera running, either by using the controls on the camera or the **CAMERA** button on the MSA-20 Handwheels.

Check the cable and connector that the sync signal is going through, and make sure the connection used is one of those specified in the **CAMERA SETUP > CAM SYNC** option (see page 19).

<table>
<thead>
<tr>
<th>Symptoms or message</th>
<th>Cause and/or action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AWAITING CAM SYNC</strong></td>
<td>The option <strong>CAMERA SETUP &gt; CAM SYNC</strong> is using a setting other than <strong>DISABLED</strong> and the controller has not yet received a sync signal from the camera (or external genlock system) to trigger the start of the move recording or playback. Start the camera running, either by using the controls on the camera or the <strong>CAMERA</strong> button on the MSA-20 Handwheels. Check the cable and connector that the sync signal is going through, and make sure the connection used is one of those specified in the <strong>CAMERA SETUP &gt; CAM SYNC</strong> option (see page 19).</td>
</tr>
<tr>
<td><strong>CAM SYNC FAILED</strong></td>
<td></td>
</tr>
</tbody>
</table>
Working with Local Area Networks

If you are using an Ethernet connection between the MSA-20 Handwheels and the head, they communicate with each other through an Ethernet Local Area Network (LAN). The MSA-20 Handwheels and head are devices on the network. Under certain circumstances you might need to change the LAN settings of the devices so that the devices not only work together, but do so when connected to another network. For example:

- If you install the MSA-20 Handwheels as part of a multi-component system.
- If you connect your MRMC equipment to a LAN.
- If you move the equipment between networks.
- If you have customised the LAN settings in a head for one of the above reasons and then sent the head back to MRMC for servicing. The service might change the LAN settings back to the factory defaults, and you will need to customise them again when you get the head back.

Introduction to LAN addresses

Each device on an Ethernet network has a suite of three addresses:

- Internet Protocol (IP) address. This is the specific address within the LAN.
- Subnet (SN) address. This defines the size (address range) of the local area network, and should normally be set to the value shown in the next table.
- Gateway (GW) address. This is the address of the device used when talking between local area networks. This should normally be set to the value shown in the next table, and you would only change it if you needed to communicate with a head that is not on the same LAN as the controller.

Together, these addresses indicate the device’s identity and location on the network. Each address is usually written as a group of four numbers separated by periods. The factory default values used in MRMC equipment are shown in the next table:
The LAN addresses of the MSA-20 Handwheels and head are **static**. That is, they will stay the same unless you explicitly change them.

<table>
<thead>
<tr>
<th></th>
<th>MSA-20 Handwheels</th>
<th>Head</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP address</td>
<td>192.168.1.235</td>
<td>192.168.1.236</td>
</tr>
<tr>
<td>SN address</td>
<td>255.255.255.0</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>GW address</td>
<td>192.168.1.1</td>
<td>192.168.1.1</td>
</tr>
</tbody>
</table>

On a given local network, the last group of numbers in the IP address must be unique for each device. All other numbers and addresses must be identical.

The LAN addresses of the MSA-20 Handwheels and head are **static**. That is, they will stay the same unless you explicitly change them.

**Hint**

Most local networks use the SN and GW values shown in the above table, so under ordinary circumstances you will only need to be concerned with IP addresses. The rest of this section therefore concentrates on IP addresses, but you might also need to inspect or change the SN and GW addresses, depending on the structure of the network that you are using to access the head.

Although a simple MSA-20 Handwheels setup has only two devices on the network (the MSA-20 Handwheels unit and the head) there are potentially three IP addresses involved:

1. **The IP address of the MSA-20 Handwheels unit itself.** This is stored in the MSA-20 Handwheels. You don't ordinarily need to change this unless you are connecting it to a local network that requires different settings.

2. **The IP address that the MSA-20 Handwheels unit looks for** when it tries to find and load the head on the network. This is stored in the MSA-20 Handwheels. This must match the next IP address...

3. **The actual IP address of the head.** This is stored in the head. This is usually the IP address shown in the above table unless it has been changed, or unless you specified a different address when you ordered the head. In any case, the factory-set IP address of a head is ordinarily printed on a sticker on the head.
You can use the **MSA-20 Handwheels** to inspect and edit all of the above stored IP addresses using the procedure given in the next section, *Managing LAN addresses with the MSA-20 Handwheels*.

If you want, you can also use Flair Motion Control Software to inspect and edit the actual IP address of a head with an unknown history. Details are in *Managing LAN addresses with Flair* on page 114.

**Managing LAN addresses with the MSA-20 Handwheels**

1. Connect the MSA-20 Handwheels and head to each other with the Ethernet cable.

2. Make sure the MSA-20 Handwheels and head have power. The menu panel on the MSA-20 Handwheels displays a prompt similar to the following:

   (C) MRMC 2016
   PRESS SELECT TO LOAD QUAD ETHER II

3. Press the **SELECT** knob to load the head.

   - If the head fails to load, you can use the remaining procedure to find the actual IP address of the head and then specify that IP address as the one that the MSA-20 Handwheels unit looks for when trying to load the head.

   - If the head loads successfully, you can use the remaining procedure to change the actual IP address of the head.

   You can also use the remaining procedure to inspect and edit the IP address of the MSA-20 Handwheels unit itself, regardless of whether the head loaded or not.

4. Use the **SELECT** knob again to choose the following menu sequence:

   **CHANGE MODE > ENGINEERING MODE**
5. Enter the PIN (4217) to access the Engineering menu.

Caution

Engineering mode is for advanced users, as applying the wrong settings here can stop the system from working. Apply the settings carefully, and make a note of the changes so you can revert to the previous settings if the system stops working.

6. Choose one of the following menu sequences:

To view or change the IP address of the MSA-20 Handwheels unit itself, choose:

   GENERAL SETUP > LAN SETUP > SET MSA IP ADDRESS

Otherwise choose...

   GENERAL SETUP > LAN SETUP > SET HEAD IP ADDRESS

7. The LAN addresses of the selected device are displayed. For example:

   IP: 192.168.1.236
   GW: 192.168.1.1
   SN: 255.255.255.0

You can edit the addresses here as required. In most cases you will only need to change the IP address.

If you are looking at the **MSA IP address** (that is, the IP address of the MSA-20 Handwheels unit) then you can inspect or edit it here to make sure the IP address is unique on the network.

If you are looking at the **Head IP address** then the displayed value is the IP address that the controller is looking for when it tries to load the head.

   • If the head loaded successfully then when you edit the IP address here, this will also change the actual IP address of the head.
   
   • If the head did not load successfully then you can enter the actual IP address of the head here so the controller can find it the next time you try to load the head.
If you don’t know the actual IP address of the head then you can find and register it as follows:

7.1 Press BACK, then FIND HEAD.

The panel displays: PRESS SLCT TO FIND

7.2 Press SELECT to begin the search.

The panel displays Searching... and then the actual IP address that it found for the head. For example:

**IP: 192.168.1.236**

(If the panel displays No head found then the actual SN and/or GW values stored in the head are different from those on the controller and the controller will not be able to find out the IP address. Contact Mark Roberts Motion Control for advice.)

7.3 Make a note of the IP address that the controller found for the head.

7.4 Press BACK then SET HEAD IP ADDRESS.

7.5 Enter the IP address that the controller found for the head.

7.6 You can check that the controller can communicate with the head on the new IP address by pressing BACK then PING HEAD and SELECT. The panel shows a blinking PING! response when it successfully tests the connection.

8. After you have inspected and/or edited the IP addresses, press BACK to return to the top of the Engineering menu.

9. Return to Broadcast mode or Film mode:

   CHANGE MODE > BROADCAST MODE

   or...

   CHANGE MODE > FILM MODE

10. Unplug the MSA-20 Handwheels power cable, then plug it back in.

11. Press SELECT to load the head when prompted.
When the head has been loaded successfully you can use the MSA-20 Handwheels to control the head, lens, and camera.

Hint

If you want to connect your head and controller to a larger network through an Ethernet hub and you need to edit the IP addresses of both head and controller, you can save time and avoid potential errors by entering and saving the IP values for the head in the menu, then using GENERAL SETUP > LAN SETUP > SET MSA IP ADDRESS > Copy head settings to copy the head LAN settings to the controller LAN settings. The IP address copy is automatically incremented by one (1) to avoid a conflict with the head.

Alternatively, you can copy the settings in the reverse direction by using GENERAL SETUP > LAN SETUP > SET HEAD IP ADDRESS > Copy MSA settings, although this direction is usually more problematic due to the need to maintain a connection with the head while simultaneously changing its connection parameters.
Managing LAN addresses with Flair

The factory-set IP address of a head is printed on a sticker on the head.

If the IP address of a head has been changed to an unknown value so you can’t load the head from the MSA-20 Handwheels, you can find out the head’s IP address either by using the FIND facility in the or by connecting the head to a Windows PC that has Flair Motion Control Software installed on it and using Flair to interrogate the head on the network.

The procedure below tells you how to use Flair to find the IP address of a head, and if necessary change it. You can also use Flair to change the IP, SN, and GW addresses of the head if necessary.

1. Find a PC that has Flair Motion Control Software installed on it, or install Flair on your own PC.
2. Attach the head to the PC with an Ethernet cable. You can use the same Ethernet cable that was connecting the head to the MSA-20 Handwheels.
3. Make sure the head has power, by checking that the power indicator LED on the head lights up.
4. Start Flair on the PC.
5. If you get any error messages, click on OK to close them.
6. When you get a message about network failure, click on the Network Setup button in the message:

   ![Network Has Died](image)

   or...

   If the Flair installation already has a valid head connection on a network then you might not get the network failure message. In this case, start the Network Setup facility manually by choosing the Setups > Network Setup menu option in Flair.
The Network Setup window, Connection tab, lists the Nodes (head connections) that Flair is looking for, as defined in the NetworkDirect.ini file. Any changes that you make and Save in the Network Setup window are saved in the NetworkDirect.ini file. You can also edit this file by using the menu option Help > View Network .ini File. If Flair cannot find the head on the network at the IP address shown then the node's status is Not connected.

7. In the Network Setup window click on Find, then on OK in the pop-up to confirm:

8. An Information pop-up displays information about the heads that Flair has found on the network:
Make a note of the head’s IP address that is displayed in the pop-up; for example 192.168.1.236.

9. To change the IP address stored in the head you can use either the MSA-20 Handwheels or Flair. If you want to use Flair to change the head’s IP address, or to inspect or change the SN or GW addresses, follow the sub-steps below:

9.1 Enter the head’s existing IP address (as shown in the Information pop-up) into the Network Setup window and click on Save.

9.2 Click on Load to reset and load the head.

Once Flair is connected to the head, any LAN address changes that you make and Save in the Network Setup window will also affect the LAN addresses stored in the head.

9.3 To change the IP address of the head, enter the new IP address into the Network Setup window now and click on Save.

The Status temporarily changes to Not connected as Flair changes the IP address in the head, then to Connected as Flair reconnects with the head at its new IP address.

9.4 To inspect or change the SN or GW address of the head, click on Find again. A pop-up shows the head’s three current LAN addresses, and the Subnet Mask (SN) and Default Gateway (GW) fields in the Network Setup window become editable. Enter the new SN and GW addresses that you want to use and click on Save.

10. Close the Network Setup window by clicking on Exit.

11. You are now done with the PC:

11.1 Close Flair by choosing the File > Quit menu option.

11.2 Disconnect the Ethernet cable from the PC, and re-attach it to the MSA-20 Handwheels, so the head and MSA-20 Handwheels are now connected.

11.3 Tell the MSA-20 Handwheels which IP address to look for by following the procedures in Managing LAN addresses with the MSA-20 Handwheels on page 110.
Zeroing lens axes with external Lens Control Motors

Axes directions
If you are using a lens with external LCMs, you need to make sure that when you move the lens controls (focus, zoom, and iris), the axis values (as displayed on the MSA-20 Handwheels) increase in the correct direction. To check this:

1. Choose menu option:
   **DIAGNOSE AXES > AXIS POSITIONS**

2. Inspect the values for the **FOCUS**, **ZOOM**, and **IRIS** displayed in the panel, as applicable to your setup. The values are updated as you move the controls:
   - **FOCUS** axis values must increase (or become more positive) as you focus near, and decrease as you focus toward infinity (\(\infty\)).
   - **ZOOM** axis values must increase (or become more positive) when you zoom in (toward the telephoto end) and decrease when you zoom out (toward the wide angle end).
   - **IRIS** (aperture) axis values must increase (or become more positive) when you close down the aperture (to, say, f/22) and decrease when you open up the aperture (to, say, f/2.8).

If any of the axes increase in the wrong direction then this will cause problems with limits and stored moves. You can fix the problem by following the remainder of this procedure.
3. Press **BACK** several times to return to the top of the menu tree, then choose **CHANGE MODE > ENGINEERING MODE**.

4. Enter the PIN (4217) to access the Engineering menu.

```plaintext
Caution
Engineering mode is for advanced users, as applying the wrong settings here can stop the system from working. Apply the settings carefully, and make a note of the changes so you can revert to the previous settings if the system stops working.
```

5. Choose menu option **GENERAL SETUP > AXES SETUP > SET DIRECTION**.

6. Invert the relevant **FOCUS**, **ZOOM**, or **IRIS** setting that you need to change. That is, change **FWD** to **REV** or vice versa for the rogue axis.

7. You now need to invert the input direction for the axis that you just changed, if you want to retain the same feel as before you inverted the axis numbering. To do this, press **BACK** several times to return to the top of the menu tree, then choose **GENERAL SETUP > INPUT SETUP > SET INPUT DIR**.

8. Invert the relevant control for the **FOCUS**, **ZOOM**, or **IRIS** axis that you changed. That is, change **FWD** to **REV** or vice versa for the relevant control.

9. Press **BACK** several times to return to the top of the menu.

10. Exit Engineering mode:
    ```
    CHANGE MODE > BROADCAST MODE or FILM MODE.
    ```

11. Re-zero the axes (including the lens axes) using the manual or automatic homing method described in **Zeroing the axes** on page 10. Note that inverting the axis direction will also change its homing direction and position.

The zero points, limits, and Zoom-Related Speed (ZRS) facility will now work correctly for your lens system.
Zeroing a lens ring with a hard stop

For any lens ring that has a hard physical stop at the end of its range (for example zoom or iris) you have a choice of configuring the lens to be zeroed manually or homed automatically.

Setting up a lens axis for manual zeroing

1. Choose menu option CHANGE MODE > ENGINEERING MODE.
2. Enter the PIN (4217) to access the Engineering menu.

3. Set the menu option HOME AXES > SET AXIS HOME TYPE to DIRECT.

This disables the homing facility for this axis and you will need to move it into the home position manually with the controls whenever you zero or home all axes in the future (page 10).

Setting up a lens axis for automatic homing

1. Choose menu option CHANGE MODE > ENGINEERING MODE.
2. Enter the PIN (4217) to access the Engineering menu.

3. Set the menu option HOME AXES > SET AXIS HOME TYPE to HARD-LIMIT.
4. Adjust the HOME AXES > SET HOMING POWER value to a suitable setting (usually 30% to 70%). The power needs to be high enough to
move the lens ring but not so high that the motor jumps out of mesh when it reaches the hard limit of the lens ring.

With this setting, homing a lens axis (page 12) automatically moves the lens ring to find both ends of the hard physical limit, recording the encoder positions at each end. The homing facility then calculates the axis range, sets the lower end to zero, and uses the range information to set the soft limits of the axis.

When a lens axis is configured for automatic homing, you can still zero it manually if you want, by using the relevant **DIRECT ZERO** option (page 11).

**Zeroing a lens ring with a slip clutch**

Some lens rings (usually focus) have no hard limit. That is, when you reach one end of travel, such as focussing on infinity, you can continue turning the ring and this will have no further effect as the ring slips against the internal focussing mechanism.

For lens rings that have no physical hard limit to their range of movement, no amount of fine-tuning of the homing power will be able to find the point at which the ring starts to slip, so you must use manual zeroing instead. To set up a lens axis with a slip clutch for manual zeroing:

1. Choose menu option **CHANGE MODE > ENGINEERING MODE**.
2. Enter the PIN (4217) to access the Engineering menu.
3. Set the menu option **HOME AXES > SET AXIS HOME TYPE** to **DIRECT**.

This disables the homing facility for this axis and you will need to move it into the home position manually with the controls when you zero or home all axes in the future (page 10).

---

Caution

Engineering mode is for advanced users, as applying the wrong settings here can stop the system from working. Apply the settings carefully, and make a note of the changes so you can revert to the previous settings if the system stops working.
Using a FIZ pot

If you plug a FIZ pot (Focus-Iris-Zoom) into your controller, you identify it in the menus by the name of the connector that you attached it to, for example ZOOM AUX. You assign it to an axis by using the Engineering menu option GENERAL SETUP > INPUTS SETUP > SET CONTROLLER. You can assign more than one control to an axis, and adjust the control directions independently of each other (page 8).

If your FIZ pot moves the axis in the wrong direction then you need to first make sure the associated lens axis moves in the correct direction relative to its axis values (page 117), then adjust the direction setting of the FIZ pot control for that axis (page 8).

A FIZ pot differs from the controls on your MSA-20 Handwheels, in that a FIZ pot has hard stops that limit its rotation range to about 355°. This has several consequences, described below.

You might reach the FIZ pot hard stop before you reach the soft limit of its assigned axis. If this happens you can do the following:

1. Press and hold the Disable button on the FIZ pot, which disables the FIZ pot output.
2. Rotate the FIZ pot back to centre (without affecting the axis).
3. Release the button and rotate the FIZ pot again in the original direction to continue moving the axis where you left off.

You can repeat this procedure as necessary until you get to the soft axis limit.

Calibrating the FIZ pot

To exploit the full ranges of both the FIZ pot and its assigned axis, you can map the FIZ pot range to the axis range. You do this as follows:

1. Choose menu option CHANGE MODE > ENGINEERING MODE.
2. Enter the PIN (4217) to access the Engineering menu.

   Caution

   Engineering mode is for advanced users, as applying the wrong settings here can stop the system from working. Apply the settings carefully, and make a note of the changes so you can revert to the previous settings if the system stops working.

3. In the menu choose **GENERAL SETUP > INPUTS SETUP > SET POT RANGE**.

4. Scroll to the control that corresponds to your FIZ pot, for example **ZOOM AUX**, and press **SELECT**.

   The **LOWER** value becomes editable.

5. Rotate the FIZ pot all the way counter-clockwise and press **SELECT**.

   The **UPPER** value becomes editable.

6. Rotate the FIZ pot all the way clockwise and press **SELECT**.

   The display shows the calculated FIZ pot range. For example **9834**.

7. Press **BACK** several times to return to the top menu level.

   Hint

   If the axis has a slip clutch that slips and misaligns the axis range with the FIZ pot range, you can re-align them by rotating the FIZ pot all the way clockwise then all the way counter-clockwise.
Notes
Appendix 3  **Back panel and accessories**

Panel summary

1. **UP LINK** DataLink In connector, used in combination with Flair boot mode (see below) to connect to an RT-12 or RT-14 interface box using a DataLink connection (as opposed to Ethernet or Serial). For pin-out information see *Up Link connector* on page 130.

2. **DOWN LINK** DataLink Out connector, used in combination with Flair boot mode (see below) to connect to a head using a DataLink connection (as opposed to Ethernet or Serial). For pin-out information see *Down Link connector* on page 131.

3. **GPIO 1** connector. General Purpose Input/Output. For pin-out information see *GPIO 1 connector* on page 129.
4. **POWER OUT** connector. For pin-out information see *Power Out connector* on page 134.

Hint

It is recommended that you do not use the **POWER OUT** socket to power the head if you are using an Ethernet connection to the head. If you do so then powering up the MSA-20 Handwheels will simultaneously power up the head, and in this instance powering up two Ethernet devices at the same time on the same network can cause communication problems between them.

5. **ETHERNET** RJ45 connector, for connection to the head or larger multi-component system. Ethernet is the recommended connection method (as opposed to DataLink or Serial). This Ethernet port is rated at 100 Mbits/sec but can operate at lower speeds of 10 Mbits/sec or less.

6. **GPIO 2** connector. General Purpose Output. For pin-out information see *GPIO 2 connector* on page 130.

7. **BOOT MODE** switch. The mode in which to start up. One of:

- **Up** position = **Normal (stand-alone) mode**, where the MSA-20 Handwheels will be used as the main controller, communicating with the head through the Ethernet or **SERIAL A** connector. This mode is also used when copying moves to and from a PC that is running MSA Archiver software (either MSA Ethernet Archiver software connecting via the Ethernet port or legacy MSA Archiver software connecting via the **SERIAL B** port).

- **Centre** position = **Flair mode**. The MSA-20 Handwheels unit only operates as a slave mimic device and boots up from Flair Motion Control Software, either directly from a PC running Flair (over an Ethernet cable, **ETHERNET** connector), or indirectly from the Flair PC, via an RT-12 or RT-14 interface box (over a DataLink cable, **UP LINK** connector). A head can be added to the system by attaching it to an Ethernet hub. A head with DataLink capability can be added to the DataLink daisy-chain by attaching the head to the **DOWN LINK** connector on the MSA-20 Handwheels.
- **Down position = Serial mode.** This is only used to update the firmware in the MSA-20 Handwheels through the **SERIAL A** connector.

8. **POWER IN** connector. The MSA-20 Handwheels unit requires a 3-pin, 24 Volt DC power supply. For pin-out information see *Power In connector* on page 134.

9, 10, 11. **FOCUS, ZOOM, EXPANSION** (Pan Bars) connectors. You can use additional controllers in parallel with those on the MSA-20 Handwheels. For pin-out information see:
   - *Auxiliary connectors for Focus, and Zoom* on page 132
   - *Expansion/Pan Bars connector* on page 133

12. **SERIAL A** connector. Used for updating the firmware in the MSA-20 Handwheels, and for connecting to a head (such as an Ulti-head) using an RS-232 serial connection (as opposed to Ethernet or DataLink). For pin-out information see *Serial A connector* on page 131.

13. **SERIAL B** connector. Used for copying moves and settings to and from a PC that is running legacy MSA Archiver software. The copying is controlled in both directions from the MSA Archiver software. However, this usage has largely been superseded by using MSA Ethernet Archiver software running over the Ethernet connection. For pin-out information see *Serial B connector* on page 131.
Connector pin-out information

Camera trigger out

When you press the CAMERA button on the MSA-20 Handwheels unit or play a move, the unit outputs a camera trigger signal (Trigger 1) from the appropriate connectors. For example:

- Pin 14 of the GPIO 1 connector on the MSA-20 Handwheels
- Pin 2 of the TRIGGER connector on an AFC head, Quad-box (on an SFH-30 or SFH-50 head), or Octo-box (on an SFH-50 head)
- Pin 14 of the CAM ACC connector on an Ulti-box (on an SFH-50 head or Ulti-head)

To control the type of trigger signal produced, see the ENABLE setting on page 18.

Auto-focus and bloop trigger out

The auto-focus and bloop trigger output signals from the controller share the same output connectors:

- Pin 13 of the GPIO 1 connector on the MSA-20 Handwheels.
- Pin 13 of the CAM ACC connector on an Ulti-box (on an SFH-50 head or Ulti-head)
- Pin 3 (Trigger 2 Out) of the TRIGGER connector on an AFC head, Quad-box (on an SFH-30 or SFH-50 head), or Octo-box (on an SFH-50 head). Note that some TRIGGER connectors might be internally configured (with a jumper setting) so that Pin 3 is a Trigger In instead of a Trigger 2 Out. If you have such a system and you want to use a bloop light or auto-focus facility then you won’t be able to use Pin 3; you will have to use Pin 2 instead, by splitting camera Trigger 1 Out signal (TRIGGER Pin 2) and using one of the splits to trigger the bloop or auto-focus when the camera starts.

In time-lapse Film mode (see TIME-LAPSE on page 18) it is assumed that you will want to use an auto-focus trigger and not a bloop light. The controller generates an auto-focus signal through the above connectors when the controller triggers the camera at each frame.
In normal Film mode (see Momentary, Pulse, or Continuous on page 18) it is assumed that you will want to connect a bloop light, and use some other means to trigger the camera's auto-focus. The controller generates a bloop light trigger pulse through the above connectors at the start of move playback, regardless of whether you have already started the camera with the Camera button (panel showing Camera running).

The bloop trigger pulse is 40ms long, and the camera trigger pulse and bloop trigger pulse are sent at the same time; there is no delay. If the camera reaction is too slow and the recording misses the bloop then you can start the camera in advance manually with the Camera button and the bloop will trigger as usual when the move starts.

Playback trigger in

You can use an external device such as a foot switch to trigger the playback of a move, by connecting the triggering device to the GPIO 2 connector on the MSA-20 Handwheels. This requires a custom connector which sends the trigger signal into the controller through the GPIO 2 connector using one of the following pins:

- pin 3 (GPI1, TRIG1)
- pin 4 (GPI2, TRIG2)
- pin 5 (GPI3, TRIG3)
- pin 6 (GPI4, TRIG4)

Once you have attached the trigger device to the GPIO 2 connector, you then use the menu option (in Film mode) REC-PLAY AXES > PLAYBACK > SET PLAYBACK TRIGGER to specify which trigger input you are using from the above list. To trigger a move with the external device you set up the move as normal using the procedures in Playing back a move - simple method on page 24 or Playing back a move - simple method on page 24 and whenever the panel displays READY TO GOTO or READY TO SHOOT you can press your external trigger device as an alternative to pressing the SELECT knob on the controller.

For further pin-out information for the GPIO 2 connector, see GPIO 2 connector on page 130.

Camera sync in

For information on which pins you can use to input the camera sync signal into the controller, see page 19.
**GPIO 1 connector**

GPIO 1 is a General Purpose Input/Output connector. This has two general purpose optically isolated inputs and one general purpose optically isolated output (open collector). This is pin compatible with the GPIO connector on some MRMC heads and can be used with a Bloop light (see page 127). The inputs can be used as sync inputs for record and playback (see page 19).

1. N/C
2. GPI2
3. N/C
4. SerialTxB
5. N/C
6. SerialRxB
7. N/C
8. GND
9. +5V
10. GPI1
11. N/C
12. N/C
13. GPO2-collector
14. GPO1-collector
**GPIO 2 connector**

GPIO 2 is a General Purpose Input/Output connector. This has 4 general purpose optically isolated inputs and 1 general purpose optically isolated output (open collector). The inputs can be used as trigger inputs for playback (see *Playback trigger in* on page 128).

1. +5V  
2. GND  
3. GPI1  
4. GPI2  
5. GPI3  
6. GPI4  
7. GPO-collector  
8. GND  
9. N/C  
10. N/C

**Up Link connector**

The Up Link (DataLink In) connector is used to connect the MSA-20 Handwheels to an RT-12 or RT-14 interface box when the MSA-20 is booted up in Flair mode and used only as a slave mimic device. For usage see page 124. Bit rate 10Mbps.

1. Watchdog–  
2. In–  
3. Out–  
4. N/C  
5. N/C  
6. Watchdog+  
7. In+  
8. Out+  
9. N/C
Down Link connector

The Down Link (DataLink Out) connector is used to connect the MSA-20 Handwheels to a head when the MSA-20 Handwheels unit is booted up in Flair mode and used only as a slave mimic device. For usage see page 124. Bit rate 10Mbps.

1. Watchdog–
2. Out–
3. In–
4. N/C
5. N/C
6. Watchdog+
7. Out+
8. In+
9. N/C

Serial A connector

Serial A is an RS232 port used for updating the firmware in the MSA-20 Handwheels, and for connecting the MSA-20 Handwheels to an Ulti-Head or any other head that can use an RS-232 serial connection (as opposed to Ethernet or DataLink). The Baud rate is 76.8 kbps.

1. N/C
2. TX-A
3. RX-A
4. N/C
5. GND
6. N/C
7. N/C
8. N/C
9. N/C

Serial B connector

Serial B is an RS232 port used for copying moves to and from a PC that is running MSA Archiver software. The copying is controlled in both directions from the MSA Archiver software. The Baud rate is 38.4kbps.
Auxiliary connectors for Focus, and Zoom

The pin assignments for these connectors are identical.

1. A+
2. B+
3. N/C
4. N/C
5. +5V
6. A–
7. B–
8. N/C
9. GND
Expansion/Pan Bars connector

1. PB1A+
2. PB1B+
3. PB2A+
4. PB2B+
5. PB3A+
6. PB3B+
7. PB4A+
8. PB4B+
9. GPO6
10. GPO7
11. GPO8
12. GPO9
13. +12V
14. PB1A–
15. PB1B–
16. PB2A–
17. PB2B–
18. PB3A–
19. PB3B–
20. PB4A–
21. PB4B–
22. +5V
23. GND
24. GND
25. GND
Power In connector

Power to supply the MSA-20 Handwheels and the power output connector. The MSA-20 Handwheels can run from 12-35 Volts DC.

1. GND
2. 24VIN
3. N/C

Power Out connector

1. GND
2. 24VOUT
3. N/C

Hint

It is recommended that you do not use the POWER OUT socket on the MSA-20 Handwheels to power the head if you are using an Ethernet connection to the head. If you do so then powering up the MSA-20 Handwheels will simultaneously power up the head, and in this instance powering up two Ethernet devices at the same time on the same network can cause communication problems between them.
Appendix 4 Specifications

Weight:  Unit with stainless steel handwheels: 11.2 Kg
       Unit with aluminium handwheels: 7.2 Kg

Power requirements: 24 Volts DC / 100-240 Volts AC

Temperature range: 0-45 °C (32-113 °F)

Humidity tolerance: 0% to 85% relative humidity, non-condensing

Dimensions: All measurements are in mm:

*Dimension with handwheels removed
# Index of menu options

<table>
<thead>
<tr>
<th>A-&gt;B WAYPOINT MOVE 20, 81, 97</th>
<th>INPUT 82, 98</th>
</tr>
</thead>
<tbody>
<tr>
<td>A2D VALUES 101</td>
<td>INPUT POSITIONS 100</td>
</tr>
<tr>
<td>ALL AXES 12, 80, 95</td>
<td>INPUT VALUES 84, 100</td>
</tr>
<tr>
<td>AUTO ENABLE 104</td>
<td>INPUTS AND BUTTONS 101</td>
</tr>
<tr>
<td>AXES SETUP 87</td>
<td>INPUTS SETUP 90</td>
</tr>
<tr>
<td>AXIS POSITIONS 84, 101</td>
<td>LAN SETUP 93, 111</td>
</tr>
<tr>
<td>AXIS VELOCITIES 101</td>
<td>LIMIT INPUTS 11, 84, 104</td>
</tr>
<tr>
<td>BACK-PAN SETUP 41, 92</td>
<td>LOW LEVEL SETUP 49, 94</td>
</tr>
<tr>
<td>BP 80, 92</td>
<td>LPF 77, 86</td>
</tr>
<tr>
<td>BP AXIS 80, 92</td>
<td>MODE 42, 43, 93</td>
</tr>
<tr>
<td>BP SCALE 41, 80, 92</td>
<td>MODIFY 82, 99</td>
</tr>
<tr>
<td>BROADCAST MODE 84, 104</td>
<td>MOVE SECONDS 81, 97</td>
</tr>
<tr>
<td>CAM SYNC 19, 77, 87, 107</td>
<td>PAIR PRESETS&amp;MOVES 83, 99</td>
</tr>
<tr>
<td>CAMERA RUNNING 18</td>
<td>PAN AXIS 80, 92</td>
</tr>
<tr>
<td>CAMERA SETUP 17, 29, 77, 86</td>
<td>PING HEAD 93, 112</td>
</tr>
<tr>
<td>CHANGE MODE 38, 84, 104</td>
<td>PLAY OPTIONS 26, 81, 82, 97, 98</td>
</tr>
<tr>
<td>COMMAND POSITIONS 100</td>
<td>PLAYBACK 23, 24, 26, 82, 98</td>
</tr>
<tr>
<td>Copy head settings 113</td>
<td>PLAYBACK ANY SPEED 27, 81, 82, 97, 98</td>
</tr>
<tr>
<td>Copy MSA settings 113</td>
<td>PLAYBACK SAME SPEED 21, 23, 24, 81, 82, 97, 98</td>
</tr>
<tr>
<td>DELETE 33, 83, 99</td>
<td>POS A 81, 97</td>
</tr>
<tr>
<td>DELETE ALL MOVES 83, 99</td>
<td>POS B 81, 97</td>
</tr>
<tr>
<td>DELETE MOVES 33, 83, 99</td>
<td>REC. SPEED 82, 98</td>
</tr>
<tr>
<td>DIAGNOSE AXES 84, 100</td>
<td>RECORD 22, 82, 82, 97, 97</td>
</tr>
<tr>
<td>DIRECT ZERO 80, 95</td>
<td>RECORD MOD 31, 82, 99</td>
</tr>
<tr>
<td>DIRECT ZERO ALL 11, 80, 95</td>
<td>REC-PLAY AXES 20, 22, 81, 97</td>
</tr>
<tr>
<td>DOWN 81</td>
<td>REPEATS 82, 98</td>
</tr>
<tr>
<td>DOWN FAIRING 21, 81, 97</td>
<td>RESTORE DEFAULTS 103</td>
</tr>
<tr>
<td>ENABLE 18, 29, 77, 86</td>
<td>RUN GENERATED MOVE 21, 81, 97</td>
</tr>
<tr>
<td>ENCODER VALUES 104</td>
<td>SELECT AXIS 80, 95</td>
</tr>
<tr>
<td>ENGINEERING MODE 38, 84, 104, 110</td>
<td>SELECT MOD AXES 31, 82, 99</td>
</tr>
<tr>
<td>E-STOP DROPPED 17</td>
<td>SELECT PLAY MOVE 24, 26, 81, 82, 97, 98, 99</td>
</tr>
<tr>
<td>FILM MODE 84, 104</td>
<td>SELECT REC AXES 22, 82, 97</td>
</tr>
<tr>
<td>FIND HEAD 93, 112</td>
<td>SELECT TL PLAY MOVE 29, 83, 99</td>
</tr>
<tr>
<td>FPS 77, 86</td>
<td>SERIAL SETUP 42, 43, 43, 93</td>
</tr>
<tr>
<td>FRAME TIME 83, 99</td>
<td>SET A-&gt;B FAIRINGS 21, 81, 97</td>
</tr>
<tr>
<td>FRAMES 83, 99</td>
<td>SET AXIS HOME SPEED 80, 95</td>
</tr>
<tr>
<td>GENERAL SETUP 78, 87</td>
<td>SET AXIS HOME TYPE 95</td>
</tr>
<tr>
<td>GENERATE A-&gt;B MOVE 81, 97</td>
<td></td>
</tr>
</tbody>
</table>
SET AXIS NAME 89
SET AXIS TYPE 39, 89
SET BACKLASH 89
SET BACK-PAN 41, 80
SET CONTROLLER 90
SET CURRENT LIMITS 49, 94
SET DAMPING 34, 90
SET DAMPING % 34, 79, 90
SET DIR SWITCHES 91
SET DIRECTION 8, 9, 78, 88
SET ENC RATIOS 88
SET ENCODER SAFETY 52, 94
SET FEATHERING 36, 78, 89
SET GOTO SPEED % 37, 79, 89
SET HEAD AXES TYPE 51, 94
SET HEAD IP ADDRESS 93, 111
SET HOME AXIS TYPE 12, 53
SET HOMING POWER 80, 96
SET INPUT DEADZONE 40, 92
SET INPUT DIR 8, 91
SET INPUT EXP 35, 79, 91
SET INPUT METHOD 40, 92
SET INPUT SCALE % 34, 78, 90
SET INTERNAL AXES 39, 39, 90
SET MAX ACCEL 35, 89
SET MAX ACCEL % 35, 78, 89
SET MAX ERROR 51, 94
SET MAX SPEED 34, 88
SET MOTOR CONTROL 50, 94
SET MOTOR TUNINGS 50, 94
SET MOVE DURATION 21, 81, 97
SET MSA IP ADDRESS 93, 111
SET PLAYBACK TRIGGE 81, 82, 98
SET POSITIONS 20, 81, 97
SET SCALE POTS 91
SET SCALE SWITCHES 91
SET SCALES 34, 78, 87
SET SOFT LIMITS 13, 78, 87
SET TEMP LIMITS 49, 94
SET ZRS 36, 79, 92, 106
SPEED 43, 93
SYNC TIMEOUT 20, 77, 87
TEST OUTPUTS 102
TEST SERIAL 102

TIME LAPSE 29
TIME-LAPSE 29, 83, 99
TL OPTIONS 83, 99
TL PLAYBACK 30, 83, 99
TYPE 30, 83, 99
UP FAIRING 21, 81, 97
ZEROING METHOD 96
ZRS MASTER 79, 92
ZRS SCALE 36, 79, 92
Index

See also: Index of menu options on page 136.

A
acceleration 35
analog lens controls 45
archiver, MSA Ethernet 55
auto-focus 19, 127
axes
directions 117
home type 53
types 51
zeroing 10
zeroing on FIZ pots 121
zeroing on Lens Control Motors 117
axis type 39

B
BACK button 7
backing up your settings 55
back-pan 41
bloop light 19, 127
BOOT MODE switch 4, 69, 125
.btl file 58
firmware .btl file 58

C
cable connections 4
CAM ACC connector 127
CAMERA button 7, 127
camera settings 17
camera sync 19
    order of events 28
Canon analog lens controls 45
Canon digital lens controls 47
CHANGE MODE 16
communication statistics (serial mode) 54
connectors
cables 4
panel 124
pin-outs 127
controls 7
directions 8
current limits 49
D
damping 34
DataLink In (UP LINK) connector 124
    pin-outs 130
DataLink Out (DOWN LINK) connector 124
    pin-outs 131
dead zone 40
deleting moves 33
dimensions 135
DIRECTION controls 7
direction of controls 8
directions of axes 117
DOWN LINK connector 124
    pin-outs 131
duplicate stepper motor outputs 39

E
emergency stop (E-Stop) 7, 17
engineering mode 38
    menu options 85
error maximum 51
E-STOP 7, 17
Ethernet 108
ETHERNET connector 125
EXPANSION connector 126
    pin-outs 39, 39, 90, 133
exponential input 35
F
feathering 36
FILM MODE 16
film mode 16, 16
  menu options 77
firmware updating 55
FIZ pots, zeroing 121
Flair
cabling, Ethernet 69
  network settings 114
  powering up 68
FOCUS connector 126
  pin-outs 132
frequency of motor drive 50
Fujinon digital lens controls 47
G
  GENERATE A->B MOVE 21
  go-to speed 36
GPIO 1 connector 124, 127, 127
  pin-outs 129
GPIO 2 connector 125, 128
  pin-outs 130
GW address 109
H
  Handwheels, mimic-only 39
  hard limit, homing type 53
  head communications statistics
    (serial mode) 54
  head, loading 5
  homing the axes 10, 12
    types 53
  humidity tolerance 135
I
  input exponential 35
  input method 40
  internal axes outputs 39
  IP address 109
L
  Lens Control Motors,
    zeroing 117
  lights 7
  limits, soft 13
  loading the head 5
  low level settings 49
M
  magnet, homing 53
  maximum error 51
  menu summary 75
    engineering mode 85
    film mode 77
  mimic input device, using the
    Handwheels as
    Ethernet connection 69
    mimic-only
      Handwheels 39
  Mobo position output 43
  modifying
    moves 31
  motor control 50
  motor tunings 50
  moves
    creating from end
      points 20
    deleting 33
    modifying 31
    playing, advanced 26
    playing, simple 24
    playing, time-lapse 29
    recording 22
    recording and using 16
  MSA Ethernet Archiver 55
    downloading 57
    using 62
  MSA Ethernet Firmware
    Updater 55
    downloading 57
    using 64
  MSA Move Archiver and
    Re-Flash Utility 42, 56, 93
N
  network settings
    controller 108
    managing with Flair 114
    managing with the
      controller 110
  PC 59, 66
O
options, menu 75

P
panel summary 124
PID system tunings 50
pin-outs 127
playing moves
advanced method 26
simple method 24
time-lapse 29
polarity of motor drive 50
position error maximum 51
POWER IN connector 126
pin-outs 134
POWER OUT connector 125
Ethernet considerations 5
pin-outs 134
power requirements 135
powering down 6
powering up 5
  Flair mode 68
Preston lens motors 44

Q
quick start 1

R
recording moves 22

S
safety 1
SCALE control 7
SCALE knobs 34
scaling
  axes 34
  controls 34
screen menu 75
screen options 75
SELECT knob 7
SERIAL A connector 126
pin-outs 131
SERIAL B connector 42, 126
pin-outs 131
serial settings 42
serial statistics 54
session summary 15
settings backup 55
size 135
slave mimic, using the Handwheels as Ethernet connection 69
SN address 109
soft limits 13
specifications 135
speed 34
  go-to 36
  zoom related 36
stepper motor outputs,
  duplicate 39
switching off 6
switching on 5
  Flair mode 68
sync, camera 19
  order of events 28

T
temperature limits 49
temperature range 135
time-lapse playback 29
TRIGGER connector 127
trigger, auto-focus 127
trigger, bloop 127
trigger, camera 127
trigger, playback 128
troubleshooting 105
  Ethernet network 108
  serial mode 54

U
underslung head, zeroing considerations 12
UP LINK connector 124
pin-outs 130
updating the firmware 55

V
vane, homing 53
W
weight 135
wheel assembly 3
wireless communication 54

Z
zeroing axes 10
  by homing 12
  manually 11
  on FIZ pots 121
  on Lens Control Motors 117
ZOOM connector 126
  pin-outs 132
zoom related speed (ZRS) 36